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PART 1: ON1 EFFECTS 2026 OVERVIEW

ON1 Effects 2026 is a complete stylizing tool for your photos, offering instant styling, powerful AI tools, 
and seamless workflow integration—all in an intuitive package. With hundreds of built-in presets, 37 stackable 
filters, and generative AI-powered tools, Effects 2026 makes it effortless to transform your photos in just a 
few clicks. Whether applying cinematic color grading, dramatic B&W, or unique textures and borders, ON1 
Effects puts complete creative control at your fingertip. 

You can use ON1 Effects 2026 as a standalone app, simply by dragging and dropping photos into the 
primary app window, or as a plugin to another photo editor such as Adobe’s Photoshop, Lightroom Classic 
CC, and Photoshop Elements, as well as other image editors like Affinity Photo, Capture One, Corel 
PaintShop Pro and Apple Photos. 

When using Effects as a standalone app, you have complete re-editability of your original files, regardless 
of their format. In addition, when you’re using Lightroom Classic, Photoshop or Apple Photos as your 
primary editor, you have the option of having your work saved so that it is re-editable inside Effects at a 
later time.
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What’s new in ON1 Effects 2026
Effects 2026’s enhancements include:

• New Depth Lighting filter lets you quickly adjust 
foreground and background lighting (page 95).

• Three new creative filters: Double Exposure (page 
96), Split Field (page 104), and Motion (page 101).

• Starting points: Set Effects up with the filters you want 
to use, every time (page 79).

• Streamlined Add Filter window lets you view only the 
filters you care about (page 81).

• One-Click Subject and Background Masks: Instantly 
isolate subjects or backgrounds (“Creating Masks” on 
page 59).

• Mask Layers: Combine or subtract multiple masks per 
layer or filter. (“Masking Properties” on page 60)

• Improved AI Edge Quality: Cleaner, more natural 
selections for details like hair, branches, and other fine 
edges. 

• Dock or float the Properties window (page 60) and 
the Layers pane (page 116) where you want.

• Support for Grayscale images.

Getting Help
You can find an extensive collection of 
video tutorials and help documents in the 
Help section of the ON1 website (on1help.
zendesk.com). This is the quickest way 
to dig into Effects. There, you can search 
our Knowledge Base for frequently asked 
questions, and more. 

You can use the Learning Hub to directly 
display videos for getting started with the 
app, search the ON1 online help system—
including with and online chat assistant—
and the ON1 Shop, where you can purchase 
add-ons and courses for Effects. The 
Learning Hub is accessible via the Help 
menu or from the Help icon at the bottom 
of the left bumper panel.  

With ON1 Effects 2026, you can produce 
high-quality masks with one click, and can have 
multiple mask layers for a filter, local adjustment or 
layer.

The Learning Hub is available directly within ON1 Effects 2026, and includes links to 
videos (which can be played directly in the Hub), ON1’s online help system, and the 
ON1 store.

https://on1help.zendesk.com
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System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 13

Windows 11 x86 or ARM 

current maintenance releases, 64 bit only

macOS 15 and above

Windows 11 x86 or ARM 

current maintenance releases, 64 bit only

PROCESSOR Windows: Four-core (minimum) or eight-core (recommended) Intel or AMD processor, 
2GHz or faster, with SSE 4.2 or Neon.

macOS: Four-Core Intel® processor or Apple Silicon (minimum) or M2 Apple Silicon or 
greater processor (recommended.

RAM 8 GB (16GB if shared with the GPU) 16 GB or more

HARD DRIVE 6 GB for installation; SSD drive recommended 

DISPLAY Windows: DirectX 12, DirectML, Vulkan 1.1, and OpenGL 4.2 compatible video card 
with 4GB VRAM (8GB recommended), 1920x1080 resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 4.2 compatible video card with 4GB VRAM 
(8GB recommended), 1920x1080 resolution (at 100% scale factor)

APPLICATION 
INTEGRATION

Photoshop CC; Photoshop Elements; Lightroom Classic; Apple Photos; Affinity Photo; 
Corel Paint Shop Pro; Capture One

current versions for all

INTERNET A high-speed internet connection and active account for activation, auto-update 
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. 
Hardware display calibration tool is recommended.

LANGUAGES English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

Installation
To install ON1 Effects 2026, double-click the Installer icon and allow it to guide you. Before installing or 
updating, close any previous versions of ON1 products that might be open. 

The first time you launch Effects, you’ll need to sign in again to your ON1 account; after that you’re 
software will be authenticated.

Your license lets you install Effects on two computers. When you enter your ON1 account info, Effects 
communicates with the ON1 activation server and registers your software for that computer.

If you wish to move your copy of Effects from one registered computer to a new one, and you are not going 
to be using the older machine, it is best to sign out of the old computer first. Open Effects and select Sign 
Out from the Help menu. This will deactivate Effects 2026 on the current machine, and you can install and 
sign in on another machine from the Application Manager.
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FREE TRIAL VERSION

ON1 Effects 2026 can also operate as a fully featured trial version for 30 days from when you first launch 
it. This gives you time to evaluate the product and see if it fits your needs. To purchase the app after the 
trial, click on the Buy Now button in the top right corner of the Effects window. (The remaining days in the 
trial period will also be displayed in the lower left corner of the main window.)

MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 Effects 2026 folder in the Applications folder. 

If a previous version of ON1 Effects is found, it will be maintained or replaced based on your preference 
during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 Effects 2026 folder in the \Program Files\ON1\ directory. If a 
previous version of ON1 Effects is found, it will be maintained or replaced based on your preference during 
installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of Effects on your computer, the installation process will move over any presets. 

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Effects 
2026. You can change your participation later, just click the Help menu, then Help Improve ON1 Products. 
To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

UNINSTALLING ON1 EFFECTS 2026

To uninstall ON1 Effects 2026, follow these instructions:

First, deactivate your product: open ON1 Effects 2026 and select Sign Out… from the Help menu. (This will 
allow you to transfer your license to another computer.)
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On MacOS, go to the Applications/ON1 Effects 2026/Documentation folder. Double-click on the Remove 
ON1 Effects 2026 application.

On Windows, go to Control Panels. Under Programs select Uninstall a program, and select ON1 Effects 
2026 from the list and click on the Uninstall button.

Launching ON1 Effects 2026

MACOS

Open the Finder, and navigate to the Applications folder. Find the ON1 Effects 2026 folder and open it, 
then double-click on the ON1 Effects 2026 application icon.

You can add ON1 Effects 2026 to your dock for easy access by clicking and holding the icon in the dock 
and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS

Open the Start screen by pressing the Window key; select ON1 Effects 2026. If you selected the “Add Icon 
to Desktop” option during installation you can also access ON1 Effects 2026 from there.

LAUNCHING EFFECTS AS A PLUGIN FROM ANOTHER APPLICATION

To launch ON1 Effects 2026 from an external application, such as Adobe Photoshop, Lightroom, Photoshop 
Elements, Apple Photos or Capture One, see the sections starting on page 6 for complete instructions.

Opening a Photo from within Effects
When you first launch Effects 
as a standalone application, 
the main window will have an 
icon in the center and an Open 
Photo button. To start working 
on a photo, you can either drag 
a photo from your desktop onto 
the icon, or you can click on 
the Open Photo button, both 
of which will open the primary 
Effects window, where you 
can start applying filters and 
other edits to your photos. 
(See “Part 2: Working in ON1 
Effects 2026” on page 23 for 
detailed information on using 
Effects’ filters and tools on your 
photos.)

You can edit a photo directly from within ON1 Effects by dragging a file into the window, or by clicking 
on the Edit Photo button. The bottom row displays the most recent photos opened with Effects
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On both MacOS and Windows, you can also drag a photo on top of the Effects 2026 icon, which will launch 
the app with that image, bypassing the startup window.

Working with Files
ON1 Effects 2026 can view and open the following file types, in RGB color or Grayscale mode, at 8 or 16 
bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC) 

• ARQ (Sony pixel-shift format)

•	 ONPHOTO (ON1 Photo format) 

When you finish working on a photo in Effects, you have the option of saving your resulting file in PSD, 
PSB, TIFF, JPEG, JPEG XL, and PNG format. If you created a layered .onphoto file, Effects will also save that 
file in the same directory as the original file. If you wish to re-edit your photo, open the .onphoto file.

FILE ACCESS WHEN USING EFFECTS 2026 AS A PLUGIN

If you use ON1 Effects 2026 as a plugin from another image editing app (Lightroom, for example), we 
recommend using the Photoshop format (.PSD) as the exchange file format for maximum compatibility. If 
your saved file will be larger than 2GB, or more than 30,000 pixels on a side, your image will automatically 
be saved in the .PSB (or Large Document) format. This is a newer version of the PSD format designed for 
larger file sizes, and is fully compatible with Effects.

When working with Effects as a plugin to Photoshop, Lightroom Classic, and Apple Photos, there are 
certain conditions in which you can preserve re-editability from within the host app. See “Using Effects 
with Adobe Photoshop” below, “Using Effects with Adobe Lightroom Classic CC” on page 8, and “Using 
Effects with Apple Photos” on page 12 for specifics on how to use these options.
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Using Effects with Adobe Photoshop
ON1 Effects 2026 is accessible from within 
Photoshop in two ways, from the File > 
Automate menu, and from the Filter > ON1 
menu. By default, using the Automate menu 
option will automatically create a duplicate of the 
current layer, and send that to Effects. If you’d 
like to change this preference, see the Plug-Ins 
tab of the Preferences window on page 144. 

Using the Filter menu option will send the 
current layer to Effects regardless of the Plug-Ins 
Preference setting. 

There are two options for editing an image in ON1 
Effects 2026: you can send the layer to Effects 
for final editing, or you can save the editing layer 
as a Smart Object in Photoshop, which will let you 
re-edit the photo in Effects with your previous settings intact.

EDITING A PHOTO FROM PHOTOSHOP FOR FINAL EDITING

To use Effects inside Photoshop, when you do not wish to re-edit your operations:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to use in Effects.

3.	 From the Filter menu, select ON1 and then ON1 Effects 2026.

4.	 When you’re finished editing your photo, click the Done button in Effects. 

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE EFFECTS EDITS

To be able to re-edit your Photoshop images at a later point 
inside ON1 Effects 2026, you will use Photoshop’s Smart Object 
technology. To do this, follow these steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart 
Object.

4.	 From the Filter menu, select ON1 and then ON1 Effects 
2026.

5.	 When you’re finished editing your photo, click the Done 
button in Effects.

Accessing Effects from Photoshop’s Automate menu will create a new layer 
above the background layer. 

Select ON1 Effects 2026 from Photoshop’s Filter menu to send the current 
layer to Effects.
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To re-edit your Smart Object layer again inside ON1 Effects 2026, double-click on the ON1 Effects item in 
the edited Smart Object layer in Photoshop (shown on the right). Effects will then launch and let you adjust 
your previous settings or make new ones.

Using Effects with Photoshop Elements
When you edit an image sent from Photoshop Elements to Effects, you are editing Photoshop Elements’ 
currently selected layer. By default, Effects makes a copy of the layer, so your original layer is saved. If you’d 
like to change this preference, see the Plug-Ins section of the Preferences window (page 144).

EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use Effects inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then ON1 Effects 2026.

4.	 When you’re finished editing your photo, click the Done button in Effects.

Photoshop Elements does not support Smart Objects, so all edits done inside Effects are final, once you 
return to Elements.

Using Effects with Adobe Lightroom Classic CC
ON1 Effects 2026 can be accessed from within Lightroom Classic CC, providing an integrated, round-
trip workflow of your images. There are two primary ways to use Effects with Lightroom, via the Edit In 
command in the Photo menu and Plug-In Extras command in the File menu. Using the Photo > Edit In menu 
gives you access to Effects for quickly editing an image that won’t require re-editing, while File > Plug-In 
Extras gives you two more powerful options for editing inside Effects, including: 

• Re-editability via ON1’s proprietary Smart Photos format (see page 11), which saves all the 
edits made in Effects, so that you can re-edit them at a later time.

• Batch processing of multiple images for editing in Effects (see page 10).

USING ‘EDIT IN’ FROM LIGHTROOM

If you wish to make quick edits on a single image 
in Effects, and don’t need to preserve your edits 
or work with multiple photos, use the Edit In 
submenu from Lightroom’s Photo menu, This is 
the easiest way to send a photo from Lightroom 
to Effects. With this option, you are using 
Lightroom’s plugin export system to control the 
characteristics of the edited file.

For quick editing of photos from Lightroom, you can choose Edit in from 
Lightroom’s Photo menu.
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File Creation Characteristics When Using Edit In

When you use the Photo > Edit In submenu, 
Lightroom will ask you each time how you wish 
to edit the selected image. You have three editing 
options: 

• Edit a Copy with Lightroom 
Adjustments, which makes a copy of 
the file that includes any edits you have 
made in the photo;

• Edit a Copy, which copies the original 
photo without any changes made in 
Lightroom; or

• Edit Original, which sends the original 
version of the photo to Effects, unless 
the photo is a raw file, in which case the 
option will be unavailable.

In the Copy File Options, you set the file type 
(TIFF, Photoshop PSD or JPEG), the color space and bit depth for the resultant file.

When you have set your options and click the Edit button, Lightroom will create a new file (or send the 
original) and launch Effects. When you’re finished, click the Done button to save your changes, close 
Effects, and return the file to Lightroom. To return to Lightroom without saving your edits, click Cancel. 

NOTE: While you cannot create a Smart Photo PSD via Edit In, you can open 
an existing Smart Photo with Edit In. Select the Smart Photo, choose Edit In > 
ON1 Effects 2026, and choose Edit Original in the window. Effects will open 
the image with your previous edits intact (Lightroom adjustments made to 
the Smart Photo will not be visible, however). Any subsequent edits you make 
in Effects will be saved with the Smart Photo when you return to Lightroom, 
and the Lightroom edits will be reapplied. (Information about the Smart Photo 
format starts on page 11.)

USING ‘PLUG-IN EXTRAS’

To use the Plug-In Extras option in Effects, select the 
image in Lightroom, go the File menu and select the 
Plug-In Extras submenu, and choose ON1 Effects 
2026. 

When you access ON1 Effects 2026 through 
Lightroom’s Plug-In Extras menu, the default file-
handling options are driven by the settings in the 

The Plug-In Extras submenu is found in Lightroom Classic’s File menu. 
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Plug-ins tab of Effects’ Preferences window. These options can be configured in advance, based on your 
workflow, and can be changed as desired. The file export options include the following settings:

• File Type: This determines what type of file 
will be created. The default is PSD, which 
does not support re-editability. You can also 
select Smart Photo PSD, JPG or TIFF, if you 
prefer those formats. One other option, 
Same as Source, will edit the original file; if 
that file is in the Raw format, it will be sent 
as a PSD file.

• Color Space: The color space menu 
determines which RGB working color 
space is used; Adobe RGB 1998, sRGB or 
ProPhoto RGB.

• Bit Depth: Sets the exported file’s bit depth 
to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of 
the newly created file.

• Stack with Original: When enabled, the 
new image is stacked with the original 
image upon return to Lightroom from 
Effects.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the 
original file will be edited, rather than having a copy made.

• Ask Every Time: When checked, Lightroom will present these export copy options whenever 
you chose an item from the Plug-In Extras submenu. Turning this option off will bypass the 
file-export window inside Lightroom, using the options set in Plug-In Preferences window. 

If you have the Ask Every Time option checked, you’ll be presented with the Export window (shown on the 
right) inside Lightroom whenever you send an image to Effects. The Export Options window lets you adjust 
the file format characteristics as needed, and is designed for users with variable workflow needs. If you 
find that you use the same options every time, then you can set those parameters in Effects’ Preferences 
window by unchecking the Ask Every Time option.

Batch processing options with Plug-In Extras 

You can process multiple images for editing in Effects via 
Plug-In Extras. Select the images you wish to work with in 
Lightroom’s Library module and choose Effects from the Plug-
In Extras submenu. The Export Options window will open with 
two batch options:

• Pause on First Photo: Use this option when you 
wish to apply the exact same editing operations to 
a group of photos. This option will open the first 
selected image inside Effects. There, perform any 

When sending a file from Lightroom to Effects via Lightroom‘s Plug-In 
Extras menu, the edited file will be created according to your settings 
in the Plug-Ins section of Effects’ Preferences window.

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Effects for 
editing. (If you have the Ask Every Time option set in 
Effects’ Preferences, Batch Options will be displayed as a 
section in the Export Options window, and you will be 
able to set the file copy options for the photos in the 
batch.)
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editing option you wish, including adding 
presets, retouching operations, cropping, 
masks, local adjustments and more. When 
you have finished with your edits, click 
Done. Effects will then apply all of the 
edits to each image in the group, and 
return you to Lightroom.

• Pause on All Photos: This option lets 
you sequentially edit the images in the 
batch. Effects will open each image in the 
destination tab, where you can edit it as 
desired. When you are finished editing 
with one photo, click Done, and Effects 
will save that photo and open the next 
one, with the previous photo’s Effects 
settings applied. (You can reset any or all 
of those settings as desired.) When you 
have finished editing the last photo in the 
group, clicking Done will save the image, 
close Effects and return you to Lightroom.

WORKING WITH SMART PHOTOS

ON1’s Smart Photo technology is a variation of the Photoshop file format that has been engineered 
to preserve all editing and retouching operations made within Effects: filter operations, masks, local 
adjustments, retouching, and so forth. Smart Photos can only be created via the Plug-In Extras export 
method as discussed on page 9, although you can re-edit them via either the Plug-In Extras or the Edit 
In menu options in Lightroom.

When you choose Smart Photo PSD as an option in the Plug-In Extras submenu from within Lightroom, 
Effects creates a standard Photoshop file with “Smart Photo” at the end of the original file’s name. As you 
work in Effects, all of your editing operations are saved in a ‘sidecar’ file that sits alongside the PSD on disk 
inside the same folder as your original image. When you are done editing and return to Lightroom, your 
edited photo will look as it did in Effects, but is completely re-editable.

To re-edit a Smart Photo from within Lightroom, select the image, and choose ON1 Effects from either the 
Plug-In Extras from the File menu or Edit In from the Photo menu. Depending upon the method chosen and 
your Effects Preferences, the Smart Photo will open automatically, or you will need to select Edit Original 
from the Lightroom export window. �   

There are a few things to know about with regards to Smart Photos and re-editability:

• Smart Photos have been specifically designed to work as a conduit between Lightroom and 
Effects to preserve re-editability. If you use Effects as a standalone app, you can open and 
view a Smart Photo from within Effects, and can re-edit the photo; as long as your sidecar file 
is present, all of your edits will be present. However, when you complete your edits, Effects 
will create a new file in any of the available file formats (PSD, PSB, TIFF, JPEG, and PNG), but 
that file will be flattened, and your edits will not be preserved.

If you have the Ask Every Time option turned on in Effects’ Plug-Ins 
Preferences window, whenever you send an image from Lightroom to 
Effects, the Export Options window will come up, letting you adjust the 
export characteristics for that image.
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• If you open a Smart Photo in Adobe Photoshop, the layers will be merged into a single, 
composite layer. If you make any edits to the photo in Photoshop and save it, re-editability in 
Effects will no longer be available.

Using Effects with Apple Photos
ON1 Effects 2026 integrates tightly with Apple Photos for MacOS and provides a seamless experience for 
enhancing your images. 

If you have Photos on your computer when you 
install ON1 Effects 2026, the appropriate plugin 
will be installed, but you will need to manually 
activate it in order to use it. To do so, go to Apple’s 
System Preferences and click on the Extensions 
icon. In the Extensions pane, click on Photos, then 
check the ON1 Effects 2026 option. This will let 
you send images from Apple Photos to Effects 
2026. (File Sharing must also be turned on in 
System Preferences for this to work.)

To edit an image in ON1 Effects 2026 follow these 
steps:

1.	 Select the image you wish to edit in Photos.

2.	 Click on the Edit button.

3.	 On the right side of the window, at the bottom of the 
editing controls, you’ll see an Extensions pop-up. Click 
that button, and choose ON1 Effects 2026.

4.	 The photo will open in Effects; make any adjustments 
you wish, and click the Done button in Effects to save 
the edited photo and return to Photos.

NON-DESTRUCTIVE EDITING WITH APPLE PHOTOS

When you send an image from Apple Photos to Effects, any settings you apply will be saved with 
the image, so that you can send the image back to Effects with your edits intact, as long as you do not 
subsequently edit that image inside Photos. To re-edit an image processed inside Effects, click on the image in 
Photos and follow the same three steps above. When your image is opened inside Effects, you will see all of 
the changes you made in your previous session. 

Once you make any editing changes to your image inside Photos, your Effects edits will be “baked in” to the 
image. You can send the image again to Effects, but your original settings won’t be visible. 

If you wish to keep your original Effects edits, duplicate the image inside Photos (Image > Duplicate), which 
will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the other 
one to preserve your Effects edits.

After installing ON1 Effects 2026 on your Mac, you must turn the Photos 
extension on via Apple’s Extensions System Preference.

In Apple Photos, click the pop-up menu next to the 
Extensions label when editing a photo and you’ll 
see the options for sending your photo to ON1 
Effects 2026.
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Using Effects with Capture One
When you edit an image sent from Capture One to ON1 Effects, Capture One creates a variant of the 
current photo. To use Effects inside Capture One, follow these steps:

1.	 Open the image you want to work on in 
Capture One.

2.	 From the Image menu, select Image > Edit With 
> ON1 Effects 2026.

3.	 Choose the file characteristics in the Basic tab 
that you wish to use in Effects—File Type, Bit 
Depth, ICC Profile, and Resolution. You can 
also set the options in the Adjustments and 
Metadata tabs as desired. When you’re done, 
click the Edit Variants button to launch Effects.

4.	 When you’re finished editing your photo, click 
the Done button in Effects.

After you’ve returned to Capture One, your new variant 
will be visible in the current collection.

BATCH PROCESSING IMAGES IN EFFECTS WITH CAPTURE ONE

You can process multiple images for editing in Effects with Capture One. Select the images you wish to 
work with in Capture One and choose Image > Edit With > ON1 Effects 2026. The Export Variant window 
will open with an additional tab, ON1 Batch, which contains a pop-up with two options:

• Pause on First Photo: Use this option when 
you wish to apply the exact same editing 
operations to a group of photos. This option 
will open the first selected image inside 
Effects. Perform any editing option you wish, 
including adding filters, applying presets, 
retouching operations, cropping, masks, 
local adjustments and more. When you have 
finished with your edits, click Done. Effects 
will then apply all of those edits to each 
image in the group.

• Pause on All Photos: This option lets you 
sequentially edit the images in the batch. 
Effects will open each image, where you can 
edit it as desired. When you are finished 
editing with one photo, click Done, and 
Effects will save that photo and open the 
next one, with the previous photo’s Effects settings applied. (You can reset any or all of those 
settings as desired.) When you have finished editing the last photo in the group, clicking 
Done will save the image, close Effects and return you to Capture One.
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Before sending multiple images to Effects from Capture One, you can also click on the Basic, Adjustments 
and Metadata tabs to change those options. Once you have all the options chosen, click the Edit Variants 
button and Effects will process that group based on your batch settings.

Using Effects with Corel PaintShop Pro
When you edit an image sent from Corel PaintShop Pro (Windows-only) to ON1 Effects, you are editing 
PaintShop Pro’s currently selected layer. To use Effects inside PaintShop Pro, follow these steps:

1.	 Open the image you want to work on in PaintShop Pro.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select PlugIns > ON1 > ON1 Effects 2026.

4.	 When you’re finished editing your photo, click the Done button in Effects.

PaintShop Pro does not support nondestructive editing with Effects; if you would like to work on a copy, 
before you send the photo to Effects, right-click on the layer in PaintShop Pro and choose Duplicate.

Using Effects with Affinity Photo
ON1 Effects can be accessed from within Affinity Photo, providing an integrated, round-trip workflow 
of your images on both MacOS and Windows. To use Effects as a plugin to Affinity Photo, you must first 
activate the plugin from within Affinity Photo.

ACTIVATING EFFECTS FOR USE WITH AFFINITY PHOTO (WINDOWS)

1.	 To setup Effects as a plugin on Windows, go first to Edit > Preferences and click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3.	 Click the Add button underneath the Plugin Search Folders area, and navigate to 
\Program Files\ON1\ON1 Effects 2026\Plug-in Files\ON1 Effects 2026.plugin. 
Click OK.

4.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Effects listed in the Detected Plugins section of the 
Photoshop Plugins preferences.

ACTIVATING EFFECTS FOR USE WITH AFFINITY PHOTO (MACOS)

Setting Affinity Photo up for MacOS is nearly identical to the Windows activation. There is only one 
additional step.

1.	 Go first to Preferences, located in the Affinity Photo menu on the top left. Click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.
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3.	 Click on the Authorize Global button at the bottom of the window. MacOS will present you 
with a dialog box that shows the root folder of your system. Click on the Authorize button in 
this box.

4.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
Applications/ON1 Effects 2026/Plug-in Files/ON1 Effects 2026.plugin. Click OK.

5.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Effects listed in the Detected Plugins section of the 
Photoshop Plugins preferences.

EDITING A PHOTO IN EFFECTS FROM WITHIN AFFINITY PHOTO

When you edit an image sent from Affinity Photo to ON1 Effects, you are editing Affinity Photo’s currently 
selected layer. To use Effects inside Affinity Photo, follow these steps:

1.	 Open the image you want to work on in Affinity Photo.

2.	 Select the layer you want to work on. 

3.	 From the Effects menu, select Filters > Plugins >ON1 > ON1 Effects 2026.

4.	 When you’re finished editing your photo, click the Done button in Effects.

Affinity Photo does not support nondestructive editing with Effects; if you would like to work on a copy, 
before you send the photo to Effects, right-click on the layer in Affinity Photo and choose Duplicate.
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Extras
ON1 Effects 2026 supports a number of additional file types that can be used in various places. These files, 
called Extras, include the following types:

• Presets for use within Effects.

• Backgrounds that can be imported and used with the Layers feature.

• Borders than can be imported and used with Effects’ Borders filter and Layers.

• Textures that can be imported and used with Effects’ Textures filter and Layers.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

• Brush shapes, which are generally saved as black-and-white TIF files. Effects can also import 
custom brushes saved in the Adobe Brush Preset format (.abr). These brushes are generally 
used within the Local Adjustments tab of Effects.

• Sun flares, which can be imported and used with Effects’ Sun Flare filter.

• Watermarks, image files (transparent PNGs) that can be used with the Export function.

• Double Exposures, image files intended for use with the Double Exposure filter.

ON1 includes a number of extras in the product when you install Effects, and you can create your own, or 
add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage your 
own extras, creating categories for each type, and deleting extras that you no longer want.

The Extras Manager window.
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HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu, then follow these steps:

1.	 Select the type of extras you wish to import from the tabs at the top (Presets, Borders, 
Textures, LUTs, Brush Shapes, Sun Flares, etc.) You can only import extras of one type at a 
time.

2.	 Click on the Import button in the footer of the left column. A dialog will appear where you 
can select the files to import. If you want to import an entire folder, open the folder, select 
the first file, then shift-click on the last file. Click Import when your selection is complete.

3.	 Select a category for your extras to be installed in. This is where you will be able to find it 
inside of the ON1 Effects 2026. You can select from an existing category or create a new 
one by clicking on the ‘+’ button at the bottom left side of the Extras window.

When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

NOTE: Most extra types mentioned here will have a corresponding Import 
button in their respective panes or windows. (For example, watermarks in 
the Export panel, or textures, borders, and LUTs in their corresponding filter 
panes.) Clicking the Import button in these instances will open the Extras 
Manager. To import backgrounds (for use with Layers) and custom brushes, 
choose Manage Extras from the File menu.

Organizing Presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Effects gives you the opportunity to add 
presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. If you would like to export a single preset, click on the preset from the list on the right side of the 
window and click Export.

What Type of Images Can I Import as Extras?

Textures may be any image file that Effects can open, including JPEG, TIFF, raw or Photoshop files. Border 
files must have a large central area that is transparent, so only files that support transparency, such as PNG, 



ON1 Effects 2026 User Guide	 Part 2: Overview	 18

can be imported as borders. LUTs can be in either .3DL or .CUBE format. Brush shapes can either be in the 
Adobe Brush Preset (.abr) file format, or saved as black-and-white TIF files. Sun flare files are usually JPEG 
files with a black background. 

NOTE: If you download an .ONPreset or .ONP file (for use with Effects), 
double-click on it to install it. For more information, see Presets on page 67.

USING EXTRAS

You access borders, textures, LUTs, sun flares, and base images for double exposures from within those five 
filter types in Effects. To use them follow these steps:

1.	 Open an image into Effects.

2.	 In the Filter Options pane, select the Borders, Double Exposure, LUTs, Sun Flare or Textures 
filter type.

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 Choose an extra from the imported category.

NOTE: Each filter will have a different method for choosing that filter’s extras. 
More detailed information on using these extras types and their respective 
filters can be found on page 90 (Borders), page 96 (Double Exposures), 
page 100 (LUTs), page 105 (Sun Flares), and page 105 (Textures). For 
details on how to use custom brush shapes within the Local tab, see page 113.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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Customizing ON1 Effects 2026
Effects has a number of parameters you can change within the app, including the creation of custom 
keyboard shortcuts; customization of various panes; setting the interface’s font size; and how the app 
works with a mouse scroll wheel.

CUSTOMIZING EFFECTS’ KEYBOARD SHORTCUTS

You can customize ON1 Effects 2026’s hotkeys via the 
Keyboard Shortcuts window. This window lets you view and 
change the shortcuts for any tool or tool option, module, 
or menu item inside Effects. You can assign shortcuts to 
items that don’t yet have a shortcut, build multiple sets of 
shortcuts as preset styles, and create a summary of your 
shortcuts that can be viewed in any web browser.

To view or change Effects’ hotkeys, choose Keyboard 
Shortcuts from the Edit menu. By default, Effects’ shortcuts 
will be displayed, organized hierarchically by the following 
groups: 

• Modules, commands for switching between 
Effects, Local Adjustments, and Layers.

• Tools, for the 17 tools available in Effects.  

• Tool Options, for the brush and mask viewing 
options available in any masking tool’s Options Bar.

• Menu, which includes all of Effects’ menu items. 

You open each group by clicking on the triangle to the left of 
the group name, or you can use the search field at the top of the Keyboard Shortcuts window to search for 
a command in any of the groups. 

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste). Also, you can’t use 
the Escape, Return/Enter, or Delete keys as a shortcut.

Modifying hotkeys

The Default preset style’s hotkeys cannot be modified, but you can create your own set of shortcuts by 
double-clicking on any command you wish to add or change. You’ll be asked if you want to create a new 
preset. Clicking Yes will let you name the new preset style, and makes a duplicate of the Default set.
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At this point, you can change any existing hotkeys—or add your own shortcuts for commands that don’t 
have them—by double-clicking in the Shortcut field for that command. The field will be highlighted, and you 
can press the key or key combination you wish to use. If that key is used by another command, a dialog will 
come up, informing you of that, and giving you the option of either keeping the existing hotkey/command 
combination, or changing it to the new command.

When you change a default shortcut to a new 
key combination—even for commands and 
options that didn’t initially have a shortcut—a 
Reset arrow will appear to the right of the 
Shortcut field. Clicking the icon will reset the 
command to its original state, from the Default 
preset style.

To delete a shortcut, double-click in the Shortcut 
field and press the Delete key. 

The Summarize button at the top of the 
Keyboard Shortcuts window will create an 
HTML table of the current set of hotkeys. You’ll 
be asked where to save the file; double-clicking 
on it will open that table in your default web 
browser, where you can view or print the list. 

You can return to the original Effects shortcuts by clicking on the pop-up menu at the top of the Keyboard 
Shortcuts window, and choosing Default from the list of preset styles. That menu can also be used to 
create a new preset or to delete an existing one that you created. The Default preset cannot be removed.

CUSTOMIZING THE DISPLAY AND ORDER OF TABS AND PANES

You can show or hide and rearrange certain aspects of Effects’ interface via the Tab option pop-up menu, 
which is found in the primary photo information panes at the top of the right panel in the app; in Effects’ 
module tabs; or in the Properties window (or pane).

To view the menu, hover over the end of the top pane in the panel, which will display the Tab options icon, 
represented by three, evenly spaced vertical lines. Clicking on the icon will display a list of the separate 
panes that make up the group. By default, all five panes (Nav, Levels, Info, History and Snapshots) are 
displayed. Selecting any of the items in that list will 
hide that pane. To restore a hidden pane, go to the Tab 
options menu and select it again.

In addition to showing and hiding certain panes, you can 
also rearrange the order of the visible tabs in the group. 
Click and hold the mouse on a tab you wish to move and 
slide it right or left to reorder the tab.

Effects’ Properties feature has a similar Tab option icon that lets you hide one of the tabs (Blending, 
Masking or Text) from view. This icon is visible in either of the Properties display options: window or pane 
in the right panel.

When you add or change a hotkey the first time, Effects will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Effects’ Default set—by 
using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Effects will 
let you know, and give you the option of keeping (Cancel) or removing (OK) the 
other command/shortcut.

Reordering panes: click and hold the mouse on a tab you wish 
to move, and drag right or left (top). When you let go of the 
mouse button, the tabs will be in a new order.
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NOTE: For information on the panes in the Photo panel, see page 27. The 
Properties window is discussed in detail starting on page 30.

USING EFFECTS WITH A SCROLL WHEEL

When you are using ON1 Effects 2026 with a mouse that has a scroll wheel, there are number of different 
options available throughout the app, on both Mac and Windows.

Throughout Effects, the scroll wheel has the following general options:

• Using the scroll wheel will pan up and down in the current window. Holding the Shift key 
down and scrolling will pan left or right.

• Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

• When working with any tool that has a brush size and feather option, press Command-Option 
(Mac) or Control-Alt (Windows) and scroll to change the brush size. To change the feather, 
press Option-Shift (Mac) or Alt-Shift (Windows).

NOTE: If you only want the scroll wheel to change brush size, turn on the 
“Only Adjust Brush Size with Scroll Wheel” option in Effects’ Preferences 
window. See “General Settings” on page 143 for more.

CHANGING EFFECTS’ FONT SIZE

By default, ON1 Effects prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of Effects’ Preferences window. Select the 
option from the Font Size pop-up, and restart Effects to have the effect take place.

ON1 Effects has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to the 
General tab of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you launch the 
app.
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CONFIGURING EFFECTS’ LEFT AND RIGHT BUMPERS

By default, the left side (bumper) of Effects’ main editing window contains 
the More menu and the Tool Well icons. The More menu lets you go 
to either the Effects or Local tabs, well as the Export, Print or Share 
functions.

You can expand the left bumper to show labels for the different tool groups 
by selecting Show Bumper Labels in the Window menu. If you would like 
to see the Print, Share and Export options on-screen, choose Show Right 
Bumper from the Window menu.

The left bumper displays only the tool 
icons by default. To display text labels 
for the tools, choose Show Bumper 
Labels. To display the Print, Share and 
Export icons, choose Show Right 
Bumper.
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PART 2: WORKING IN ON1 EFFECTS 2026
ON1 Effects 2026’s photo-editing power consists of two distinct editing functions, separated into tabs:

• Effects is your stylization center, with 37 filters that can be stacked in any order, all with 
extensive blending and masking options. And, with ON1’s Mask AI technology, you can apply 
Effects filters solely to specific regions in a photo with a single click. 

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease. You can 
also use custom brushes and the Paint with Color option to add overlays like clouds, trees, 
and more to your photos. For more about local adjustments, turn to page 110.

To switch between the different functions, click on the appropriate tab. While you work on an image, all of 
your settings in each tab are saved while you edit. 

When using Effects as a plugin from Affinity Photo, Capture One, or Photoshop Elements, you can still 
move between the Effects  and Local tabs, but your photos will not be re-editable once you leave Effects. 
If you’re using ON1 as a plugin with Lightroom Classic’s Smart Photos file format option (page 11), 
Photoshop Smart Objects (page 6) or with Apple Photos (page 12), your work can be re-editable.

To help you save time and create the looks that you love best, ON1 Effects 2026 also includes a robust 
preset system that lets you save settings made in the Effects or Local tabs for applying to other photos. 
Editing presets can be applied at any time are re-editable. (Presets are discussed in detail on page 67.)

You can also create multi-layered composites inside Effects, via the Layers function. Using layers, you can 
add other photos, backgrounds, replacement skies, textures and more. Each layer has its own Effects and 
Local Adjustments stacks, and has access to all of Effects’ masking tools and operations. (See page 115 for 
details on working with Layers.)
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ON1 Effects 2026 Main Screen Overview

Effects provides you with an easy-to-use work space for editing your photos. Below is an overview of the 
main sections of the Effects window:

A.	Tool Well: Tools for working within Effects 2026.

B.	 Trial Period/Close Left Panel: When in demo mode, this displays the number of days left in 
the trial period. Clicking the bottom icon closes/opens the Filters/Presets panel, providing 
more screen space for the preview window.

C.	 Filters/Presets panel: Tabbed panels with (a) a list of all installed presets (by category), or (b) 
a list of all Effects filters. 

D.	Search: Searches presets and filters by name.

E.	 Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask.

F.	 Tool Options bar: Options and settings for currently selected tool.

G.	Preview Window: Displays the current photo in detail view.

H.	Photo Information pane: Navigator, levels (histogram) general photo information, edit history 
panel, snapshots.

I.	 Masking/Blending pane: Creates and refines masks for the current filter or layer; sets 
blending modes. (Can also be set in the left panel, or as a floating window.)
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J.	 Layers pane: Add, edit and manage layers. (Can also be set in the left panel, or as a floating 
window.)

K.	 Effects/Local tabs: Tabs for accessing the Effects and Local Adjustments sections of the 
Effects window. Clicking on each tab brings up the settings for that tab.

L.	 Filter stack: Where you add filters to apply to your photo. To add a filter, you can click on the 
Add Filter button at the top of the stack, or use the Presets or Filters panel on the left side of 
the window.

M.	Output: Shortcuts for printing or exporting the current photo.

N.	Reset bar: Reset All (restores settings to the original state when you opened the photos), 
Cancel (closes the photo without saving), Done (closes photo, opens a dialog box to let you 
specify the file name and type of the finished photo).

ALTERNATIVE VIEW MODES

In all of the preview modes inside Effects, you have three options for arranging the workspace:

• The default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys 
on the keyboard to move from photo to photo. This option is helpful when you wish to view a 
selection of photos as large as possible without any distractions. 

Effects provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the space bar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
space bar will reposition your image at the current view level.

Generative AI Technology and Effects 2026
Effects 2026’s Crop tool and the Generative Eraser utilize generative AI technology that can run locally on 
your computer or via a cloud-based option through Stability AI (which requires an open connection to the 
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Internet to run). These tools allow photographers to enhance images with speed and precision, and while 
generative AI isn’t perfect, it does offer exciting opportunities for creativity and efficiency in photography.

The Generative Eraser is an evolution of the Perfect Eraser, and is ideal for removing large distractions 
from your photos. However, this doesn’t mean it will be suitable for everything. We still recommend the 
non-destructive Healing Brush for small or simple retouching tasks, which works well in many everyday 
situations. When dealing with more challenging tasks like removing photobombers, bystanders, signs, 
braces, cars, etc., the Generative Eraser excels. 

The workflow is slightly different, as generative AI doesn’t produce the same result when identical input 
is given repeatedly. Therefore, the results must be saved rather than replayed like other non-destructive 
settings. The output from the Generative Eraser is applied to a new copy of the layer you’re working on, 
allowing you to retry as much as you like to achieve the desired result.

Generative Crop as the next step beyond content-aware crop. It’s an option when you use the crop tool 
to expand the canvas beyond the original photo, allowing you to recompose the shot if necessary. It’s like 
zooming out after the fact. The results from Generative Crop far surpass the quality of content-aware crop. 
Like the Generative Eraser, its results are created on a new layer copy.

GENERATIVE AI PROCESSING OPTIONS

Effects has two primary AI diffusion models for use with the Generative Eraser and the Canvas Extension 
option in the Crop tool. If you wish to run the processes locally, you can choose ON1’s Local Gen AI; 
alternatively, you can use a cloud-based service from Stability.ai, the creators of Stable Diffusion.

To use Local Gen AI on your system, you’ll need a modern GPU with at least 4GB of VRAM. These GPUs 
include the RTX 1070, 2060, 3050, and 4060 or better for NVIDIA or the Radeon 570, 5300XT, 6400, or 
7600 for AMD, all with the latest drivers installed. Apple Silicon systems with 16GB or more RAM will work 
as well. Running these features locally instead of in the cloud protects your privacy since no photos go 
there. It also allows us to provide generative AI features without requiring a subscription. Keep in mind that 
diffusion models are typically run in the cloud on large servers equipped with specialized GPUs designed 
for AI processing. To make these models functional on standard Mac or PC gamer-level GPUs, we’ve had to 
scale them down. While they should generally yield acceptable results, they may not be as precise as some 
cloud-based solutions. 

You can also sign up for an account with Stability via their consumer portal, DreamStudio, at dreamstudio.
ai. Signing up is free; you receive 25 free credits when 
you sign up, and you are given a unique key that is 
assigned to your account, which you enter into 
Effects. Each tool usage currently costs 3–4 credits, 
and credits were priced at one cent (US) at the time of 
this writing. Any time you use Stabilty to generate 
content, you must have a connection to the internet.

The Stability integration can sometimes yield different 
results, which may be better in some cases, and 
it can also be faster depending on your hardware 
specifications. Stability’s terms of service protect your 
privacy.

You change the AI model in the Tool Options bars for the Crop and 
Generative Eraser tools. When you select the Stability AI model for 
the first time, you need to paste your Stability key into the Key field, 
after that, it will be stored in Photo RAW for future use.. 

https://dreamstudio.ai
https://dreamstudio.ai
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Selecting the AI model to use

Each time you use either the Canvas Extension option (Crop) or the Generative Eraser, you have the 
option of choosing which model to use, Local Gen AI for processing locally or Stability.ai, for cloud-
based processing. Select it from the Canvas Extension pop-up in the Crop tool or the Gear menu in the 
Generative Eraser Tool Options bar. The first time you choose Stability AI, you need to enter your Stability 
key into the Key field; Effects will retain the key for future sessions.

Information on the Crop tool can be found on page 33; the Generative Eraser is discussed starting on 
page 55.

NOTE: Anyone can use the Stability AI model with Effects 2026; if your system 
cannot meet the requirements to use Local Gen AI, and you do not wish to use 
Stability, you can select the Local NonGen AI option in the model pop-up for 
either the Crop or Generative Eraser tools.  In general, your results won’t be 
close to either of the other two models, but they may be acceptable for certain 
types of photos.

The Photo Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info, History 
and Snapshots panes. These tools can be useful for inspecting and viewing details of your image, as well as 
for looking at all of the editing adjustments made during a session.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white 
square region marks the image area that is visible in the 
preview pane. You can pan your image by clicking and 
dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 50% 
and 25%). Click on one of the buttons to change the view. 
Fit zooms to fit the current canvas size, while 100 zooms 
to 100%, displaying the actual pixels.

NOTE: You can also use your mouse’s scroll wheel to pan and zoom inside your 
photos. See “Using Effects with a Scroll Wheel” on page 21 for specifics.
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THE LEVELS PANE

This gives you a color chart of the shadow, midtones and 
highlight areas based on the image RGB values (commonly 
known as a histogram). This is useful to show areas within 
the image that may be clipping. Clipping is when your 
image contains pure blacks or white and can signify loss 
of highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of 
each end is a triangle. If the triangle is lit, there is clipping on that side of the histogram. If you click on 
the arrows, you will activate the clipping overlay on your image, which displays the areas that are clipped. 
Those areas with a blue overlay are pure black, while the areas with the red overlay are pure white. You can 
turn the clipping view off again by clicking on one of the triangles. You can also temporarily enable clipping 
view by holding down the J key at any time. The clipping view is useful when you are making adjusts to the 
brightness and contrast of your image. (See page 76 for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in 
an easy-to-read format. This metadata includes camera 
make and model; lens focal length; capture date and 
time; file type; ISO setting; shutter speed; aperture; and 
exposure compensation.

The Info pane also displays file-specific date, including 
name and image dimensions.

Note that, when editing a photo in Effects as a plugin from Lightroom Classic, Photoshop, Photoshop 
Elements, Affinity Photo, Corel Paintshop Pro, or Apple Photos, the Info pane is not visible.

NOTE: The Settings Applied section found in earlier versions of Effects now 
resides in the Layers pane. See page 115.

THE HISTORY PANE

ON1 Effects 2026 has a robust Undo capability, which 
is helpful when you wish to back up a few steps during 
the editing process. When you want to go back further, 
it can be tedious to keep pressing Command/Control-Z. 
That’s where the history pane can be extremely useful. 
It displays every adjustment made during an editing 
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session. From the History pane, you can scroll through your edits, all the way back to the state of your 
photo when you opened it for editing.

As you work, the History pane tracks all of your edits—even when working with layered files—adding each 
change you make to the top of the pane. History displays not only the adjustment, but in many cases will 
display the settings of sliders in the various panes and filters. 

You can scroll through the list, and, if you click on an item, Effects will “roll back” your edits to the spot you 
clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire edit 
history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that point 
on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo.  

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.

THE SNAPSHOTS PANE

The Snapshots function lets you save a photo’s editing 
“state” at any point in the editing process, so that it 
can be returned to at a later time when you re-open 
the photo. When you create a snapshot, it saves all of 
the current photo’s edits as they are in that moment. 
Once saved, you can get back to that state in the editing 
process at any time by clicking on the snapshot’s name 
in the pane. You can also create multiple snapshots and 
move from state to state by clicking on the appropriate 
snapshot in the list. 

Snapshots can be useful when you wish to save and 
compare different applications of effects, such as 
comparing color vs. black-and-white treatments. They’re also helpful when you’re not sure about where to 
take an edit, and you want to ensure that you can get back to a specific point in the editing process.

Snapshot basics

The top of the Snapshot pane for each photo will always have an item called “Original,” which is the original 
state of the photo as it was first opened. In addition, at the conclusion of every Effects session for that 
photo, Effects will automatically save the final editing state as a snapshot, with the date and time you 
closed the photo, and an “(Auto Save)” label at the end of the snapshot name. 

To create your own snapshot, go to the Snapshots tab and click the New Snapshot button. A window will 
open asking you to name the snapshot; by default, it will be the current date and time, but you can enter 
any descriptive text you would like. There is no limit to the number of snapshots you can create.

When you create a snapshot, you are saving the state of a photo’s 
edits as it was at that point in the editing process. Clicking on a 
snapshot in the pane will return you to that state at any time.
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When you wish to return to the editing state defined by a specific snapshot, click that item in the Snapshots 
pane. You can also move from snapshot to snapshot, which can be helpful for comparing edits. To then get 
back to where you were at before you clicked a snapshot, choose Undo, or, if you’ve applied a number of 
edits from that snapshot state forward, you can use the History pane to roll back to the pre-snapshot state.  

Managing snapshots

There are a few snapshot-management options available, which can be called up by right-clicking on any 
item in the Snapshots pane. These options include:

• New Snapshot: creates a new snapshot with the current editing state.

• Delete Snapshot: removes the snapshot permanently from the pane.

• Rename Snapshot: renames the snapshot; this 
includes autosaved snapshots, although Effects 
preserves the (Auto Save) label.

• Update Snapshot with Current Settings: saves 
the current editing state to the selected snapshot, 
overwriting the previously saved state.

• Create Version from Snapshot: Not applicable in 
Effects 2026.

 The Properties Window
The Properties window is used for setting blending modes and masking options in the Effects and Local 
tabs, as well as the Layers pane. By default, it works as a window, but it can also be configured to be nested 
as a pane in the right- or left-side control panel.

The Properties window is closed by default, but opens when you 
click on the blend mode icon, or when you create or click on a 
mask. 

For information on using the blending modes, see page 85; the 
Properties window’s masking options are detailed on page 58.

Configuring Properties

You can configure the Properties window’s visibility in a number of 
ways, via the Windows > Properties submenu in Effects:

• The Show submenu option turns the pop-up window (or 
nested pane) on or off. When set to off, the pane will be 
hidden, but will reappear once a masking tool has been 
selected.

• The Nest submenu option relocates the Properties 
window to a pane in the left side of the Edit module, above the Layers pane.

• The Auto Collapse option collapses either the window or pane to just the tab headings 
(Blending or Masking). Positioning your mouse over any of the tabs displays the entire pane. 

Right-clicking on an item in the Snapshots pane gives you a 
list of management options for that snapshot.

Properties can be set to either a floating window or 
embedded in the right or the left panels.
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The Tool Well
Effects has 17 tools that are accessible via the Tool Well on the left side of the screen. Some tools—Crop, 
Transform, Super Select AI, and View—are self-contained within the tool icons. Masking and retouching 
tools are nested within separate tool groups and are accessible via the Tool Options bar at the top of the 
screen when you click on one of those tool icons.

• Crop Tool: Trims an image to your desired size or ratio. Also supports generative expansion 
via ON1’s Local Gen AI technology. Shortcut key: C

• Transform (Move) Tool: Moves and changes the size and rotation of your layer. Shortcut key: V

• Super Select AI Tool: Lets you select regions in an image by clicking on them and then applies 
Effects filters or local adjustments automatically to those regions. Shortcut key: K

• Masking Brush (Mask group): Mask large similar 
areas quickly. (Includes Perfect Brush option.) 
Shortcut key: B

• Gradient Mask (Mask group): Applies a selective 
gradient as a mask in any filter (or to the entire 
stack). Shortcut key: M

• Quick Mask AI Brush (Mask group): Generates 
masks (for existing filters and local adjustments) 
by clicking on regions in a photo. Shortcut key: W

• Quick Mask Brush (Mask group): Create 
high-quality masks with only a few strokes as 
guidance. Shortcut key: Command-Option-Shift W 
(Mac); Control-alt-Shift W (Windows)

• Line Mask Tool (Mask group): Create masks 
using straight lines, with the capability to add 
curves and adjust mask points. Shortcut key: Shift-P

• Refine Brush (Mask group): Lets you refine an existing mask’s edges, to help mask difficult 
areas, such as hair. Shortcut key: N

• Chisel Tool (Mask group): Removes fringes from the edge of a mask. Shortcut key: Shift-H

• Blur Tool (Mask group): Blurs the edges of a masked area to help it blend more naturally. 
Shortcut key: L

• Healing Brush (Retouch group): Paint over a distraction and a matching area of your photo is 
magically blended on top to replace it. Shortcut key: Q 

• Generative Eraser (Retouch group): Uses ON1’s Local Gen AI technology to remove large 
distractions from a photo. Shortcut key: Option-Shift-Q

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines. Shortcut key: 
Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another area. Shortcut key: 
Shift-S
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• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

When working with nested groups, the icon of the currently selected tool will be visible in the Tool Well.

 

NOTE: The tools in the Mask and Refine groups are only accessible once you 
have applied a filter or preset to your photo. Clicking on the Local group will 
automatically create a new local adjustment layer.

ACCESSING AND USING TOOLS

To access a tool, click on the tool or use the 
shortcut key for that tool. When selected, the 
cursor will change, and you will see the tool icon 
and a set of options for the tool in the Tool Options 
bar above the Preview window. (The tool will be 
highlighted in your system’s accent color.)

If the selected tool is part of a tool group, the first 
tool in the pair is the primary tool for that group: 
Masking Brush for the Mask group, Healing Brush 
for the Retouch group. Other tools in that group 
will be visible in the drop-down menu next to the 
primary tool. 

ADJUSTING TOOL SIZING PARAMETERS

When using any of the tools that have Size and Feather options, you have multiple ways to adjust those 
parameters:

• In the Options Bar for each of those tools, you can use the slider in the Size and Feather 
fields to increase or decrease the amount.

• You can use the left and right bracket keys on your keyboard — ‘ [ ‘ and ‘ ] ’ — to adjust the 
size; additionally, hold down the Shift key to adjust the feather. 

• You can also use your mouse’s scroll wheel. Press Command-Option (Mac) or Control-Alt 
(Windows) and scroll to change the brush size. To change the feather, press Option-Shift 
(Mac) or Alt-Shift (Windows).

• You can also use your pressure-sensitive tablet, if you have one. Settings to turn that option 
on will be found in the Tool Options bar’s Gear menu for the tool.

The options bar for the tool groups—like the Masking Tool group shown 
here—will display the primary tool (Masking Brush in this instance) for the 
group. To select a different tool in the group, click the drop-down menu 
and select that tool. 

Each tool in Effects—with the exception of the View tool—has an Options Bar, where you can adjust the settings for that tool. Shown here are the options for 
the Retouch Brush.
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Standalone Tools
The standalone tools – Crop, Transform, Super Select AI, and View – perform a single task inside Effects.

CROP TOOL

This tool lets you crop your image, and is non-destructive while you’re working in Effects. It has a 
generative expansion option that lets you expand the photo canvas, filling the edges of a photo’s 
frame with realistic detail.

To crop an image without content-aware fill, select the Crop tool from the Tool Well, which will display the 
crop overlay. Select any preset crop ratio you would like to use from the Options bar — the default is 
Freeform, which lets you crop in whatever size or ratio you would like. Choosing a preset size (like 4x6) will 
display the crop overlay at that chosen aspect ratio.

Adjust the corner handles of the crop overlay to get the area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are 
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles. 
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows 
you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

The Crop interface, with the Crop Overlay pop-up menu open.
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AI Auto Crop and Level

To the right of the Aspect pop-up menu is the AI Auto Crop 
and Level button. To use it, select an aspect ratio and click 
the button. Effects will analyze the photo and automatically 
crop and level it for you at the chosen aspect ratio, and 
the button will turn blue. If you don’t like the crop, you can 
override it, or choose an alternative aspect ratio.

AI Auto Crop and Level operations can be saved in a preset (see page 133), or via the Copy Settings 
command (see page 140), which lets you apply the auto crop aspect ratio to a group of photos.

NOTE: If the Freeform aspect ratio is selected when you click the AI Auto Crop 
and Level button, ON1 Effects will use the photo’s original aspect ratio.

Expanding your crop with Local Gen AI

Using Local Gen AI (or Stabilty AI), you can use generative AI to expand the boundaries of a photo, building 
new content based on the characteristics of the photo. Select the Canvas Extension option in the Crop’s 
Tool Options bar, and extend the crop frame outward from the boundaries of the photo in the direction you 
wish to expand. When you click Apply, Effects will generate the extended area and create a new layer with 
the results. If you would like to try a different expansion, you can either use the Undo command, or, if you 
would like to keep the old expansion, hide the expanded layer, select the base (original) layer, and redo the 
cropping operation.

To use AI Crop and Level, choose an aspect ratio, and click 
the AI button. Photo RAW will suggest a crop and the 
button will turn blue.

When you select the Canvas Extension option in the Tool Options bar, you can extend the canvas beyond the boundaries of the 
existing photo, using ON1’s Local Gen AI (or Stability AI). Drag the crop border out from the photo, click Apply, and Effects will fill the 
area based on the characteristics of the edges in the photo.
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See page 26 for information on the different generative models, system requirements, and why you 
would want to use one or the other in certain situations.

Crop overlays

When you select the Crop tool, Effects has the option to display guidelines 
as an overlay on top of your photo. These overlays can be used as 
compositional aids for cropping. Effects includes a number of overlays that 
you can display during a crop session, and they can be accessed from the 
overlay pop-up menu in the Tool Options bar when the Crop tool is active. 
There are seven options — Rule of Thirds, Grid, Diagonal, Triangles, Golden 
Ratio, Golden Spiral, and None — and you can easily go back and forth 
between them as desired while cropping. 

In addition to overlay type, there are two other sets of options in the pop-up 
menu: 

• You can choose to have the overlay displayed all the time during a crop session, or to have 
Effects only display the overlay when your cursor is in the preview area of the workspace.

• When working with the Triangles or the Golden Spiral overlays, the Flip Overlay options will 
be visible, letting you flip the orientation of the overlays horizontally (Golden Spiral only) or 
vertically (Golden Spiral and Triangles).

Crop Tool Options Bar:

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Aspect pop-up: Lets you choose aspect ratios, from Freeform constrained or custom preset 
ratios.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

• Canvas Extension: Selects a model (Local Gen AI or Stability AI) to expand the canvas size, 
filling the edges of the photo with new detail, using generative AI.

• Reset: Resets the crop area to the size of your original photo.

• Cancel: Cancels the crop application.

• Apply: Applies the crop.
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Creating custom crop sizes

In addition to the preset crop 
ratios provided, you can create 
your own custom crop sizes. 
The bottom of the crop preset 
pop-up menu has a Custom 
submenu, which lists all of 
your custom ratios. To add a 
size, choose Manage Custom 
Sizes from the submenu. To 
add a new ratio, click the Add 
button, then enter a name, and 
the width and height ratio you 
wish to create (the units will always be “ratio” when you create a custom preset for the Crop tool). You can 
add as many as you’d like and click OK. The new crop ratios will appear in the Custom submenu.

TRANSFORM (MOVE) TOOL

The Transform tool is used to manipulate the contents of a layer, and works even if the only 
layer you have is the base photo layer. A layer may be repositioned, sized or rotated using the 
Transform Tool. When the tool is selected, handles will appear on the edges of the selected 
layer. You use these handles to manipulate the image. When you are done, click the Apply 

button in the Tool Options bar.

The Transform tool is layer-dependent, and each document layer can have its own transform operations. 
This can be useful when compositing photos, or applying backgrounds and textures in a multi-layered file. 

Repositioning a layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

Resizing a layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition 
to the preset ratios. You can create your own presets via the Manage Custom Sizes submenu option, 
which opens the Custom Document Size Presets window (above right).
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Flipping a layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a layer after a move

The Reset All command inside Effects will not reset transforms made with the Move tool. To reset your 
layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 

(For detailed information regarding Layers functionality, see “Part 4: Working with Layers” on page 115.)

Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.

• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 



ON1 Effects 2026 User Guide	 Part 2: Working in Effects	 38

SUPER SELECT AI TOOL

The Super Select AI tool is a specialized selection tool that lets you make multiple selections 
and automatically apply local adjustments or Effects filters to the selected area.

To use this tool, select it from the Tool Well. Super Select AI will quickly analyze the regions in 
the photo and, as you move your cursor around the photo, Effects will display the various regions in your 
photo as blue overlays. Clicking on a region will create a selection and leave the selected area blue. If there 
are additional regions you wish to select, hover over the new area and click. To remove a selection, click on 
it a second time.

When you have completed your selection, choose an option from the Apply pop-up menu in the Tool 
Options bar, or right-click on the photo to get the same menu. From the menu, you can choose to add either 
a Local adjustment or an Effects filter that you wish to be applied to the selection. If you have Show Styles 
Flyout turned on, you will also see the different styles for the Local adjustments and Effects filters. 

As you mouse over the menu, Effects will display the effects of each option in real time on your photo. 
When you select an option, Effects will create that local adjustment or filter — in either the Local or Effects 
tabs — and apply the adjustment to the chosen selection and remove the current selection. 

If you would like to add another adjustment to the photo, you can make a new selection and choose the 
effect you with to apply. When you are finished adding adjustments, click the Done button; the Super 
Select AI tool will be deselected, and Effects will choose the Zoom tool.

The Mode menu in the Super Select AI Tool Options bar has two options: Paint or Erase. Paint is used to 
create the selection, use the Erase option to remove areas from the selection.

When you pick the Super Select AI tool and hover over a region in a photo, Effects will display that area in blue. Clicking on the area will create 
the selection, and you can keep clicking areas in the photo to build on the selection. Once you have the selection you want, you can choose to 
add a local adjustment layer or any Effects filter from the Apply menu.
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While the masks created by the Super Select AI are generated automatically, they operate like any other 
mask created in Effects. This means you can use any of the other masking and mask-refinement tools to 
adjust and refine the finished masks.  (See “Masking Basics” on page 58 for more.)

Super Select AI Tool Options bar

• Apply: For choosing the local adjustment style (Local tab) or the Effects filter and style to be 
applied. 

• Mode: Sets the masking mode for selections when using the Super Select AI tool. Paint In 
means that the local adjustment or filter will be applied to the selection; Paint Out means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Feather: After you have added an adjustment or filter (by clicking on the Add button), this 
option will apply a feather to the edges of the selection.

• Show Styles Flyout: When checked, the pop-up menu will show the Styles associated with 
that local adjustment or filter.

• Done: Quits the tool and selects the Zoom tool.

VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in ON1 Effects, adjusts 
the magnification of the image in the Preview window. With the Zoom tool selected, click in the 
Preview window to zoom in and center the image at the location clicked. Hold down the Option/
Alt key to display the Hand tool, which lets you pan around the magnified image. You can also 

double-click the Zoom tool in the Tool Well to set the image to 1:1 (or 100%) magnification view, which 
shows every pixel. This is best when examining small details.
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Masking Tools
The Mask tool group has a total of eight tools, designed to help create and refine selections. Depending 
upon the complexity of the masks you are trying to create and manipulate, you will often use multiple tools 
to get achieve the perfect mask. 

We go into much more detail later in the guide, but, at its simplest level, a mask shows or hides the effect 
of the filter or adjustment. Masks have no color: they are grayscale, and the tones range from pure white 
to pure black. A mask that is completely white displays the entirety of the effect being used, a mask that 
is completely black hides that effect. Shades of gray are in effect the opacity of the mask. Darker shades 
reduce the effect, lighter shades let more of it through. For more complete information on masking and 
mask refinement, see page 58.

MASKING BRUSH

The Masking Brush is one of two tools used for masking filters in Effects and creating masks in 
Layers. Selected, the Masking Brush cursor looks like two concentric circles, one representing 
the inner hard edge of the brush, the other, the soft outer, feathered edge of the brush. At the 
center of the brush is either a plus or minus. The plus means that you are painting “in” a filter’s 

effect, while minus means the brush mode is set to paint out.

Masking Brush Tool Options Bar

The first icon is for the Masking Brush Options. Clicking on that displays a pop-up menu that contains all of 
the options available for the tool (see page 41 for more). The five remaining items in the options bar are 
the most common tasks used with the Masking Brush, and include:

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. 

• Opacity: This controls the transparency of the brush, and ranges from 1 to 100 percent. You 
use a high opacity to paint quickly and hide large areas. You use a lower opacity for blending 
areas together or for subtle work. You can also control the opacity with a pressure-sensitive 
tablet, or by pressing Option (Mac) or Alt (Windows) and one of the number keys on your 
keyboard. Each number represents an opacity percentage from 10% (1) to 100% (0).

TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
White in a mask represents 100% of an effect and black (0%) represents no 
effect, and opacity settings in between will show a percentage of the effect.
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• Paint Mode: There are two modes, Paint and Erase, and they control whether you are 
painting in (restoring the effect) or painting out (hiding the effect), respectively. You can tell 
your current mode by looking at the plus or minus icon in the center of the brush. If the icon 
is minus, you are painting out (Erase), and if the icon is a plus, you are painting in (Paint). You 
can change the mode in the Tool Options bar, by pressing the X key, or by holding down the 
Option (Mac) or Alt (Windows) key temporarily. 
	 To invert the mask (turn it from black to white), in order to paint a filter’s effect into your 
image choose Invert Mask from the Mask Properties window.

• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection 
technology to help create precise selections and masks. When you turn the 
option on—by clicking on the Perfect Brush icon in the Options bar—the Masking 
Brush collects the colors under the center of the brush and applies the effect 
only to those colors. This protects the adjustment from being applied across 
edges, such as tree branches. 

MASKING BRUSH OPTIONS MENU

The Masking Brush Options pop-up menu has six sections, Styles, Properties, 
Shape, Perfect Brush, Manual Spacing and Pressure:

Styles

The Style pop-up lets you save the current brush state for use at another 
time. Selecting a saved item from the menu will open that saved brush’s 
characteristics.

Properties

The properties section mirrors the Size, Feather, and Opacity options in the 
main tool options bar, as well as the current Paint Mode setting. Two additional 
options are also available, Flow and Angle:

• Flow: The rate at which the brush is applied, up to the Opacity setting. 
With a low flow number, as you brush back and forth, the brush color 
will build up to the Opacity setting. At 100, the brush stroke is applied 
at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, 
round brush shape, this setting has no effect; it is more useful when 
working with custom brush shapes (see below). You can also rotate the 
brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) 
and the left or right bracket keys (‘[‘ or ‘]’).

Shape

The Shape menu displays a list of all custom brush shapes in your library. The 
top item in the list is the default, round brush, which is the standard brush for 
working with masks in the Edit module. Custom brush shapes can be useful 
when you want to create specialized creations or enhanced photos: you can 
paint in stamps, watermarks, and other shapes in the Edit module’s Local 
Adjustments tab. 

Perfect Brush 
icon.
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For example, you could use a custom cloud brush to add interest to a lackluster sky, or you could create 
your own watermark and apply it precisely.

For more on using custom brushes in Effects, see page 113.

Perfect Brush

You can tune the Perfect Brush settings via the Threshold and Transition options: 

• Color Threshold: This option lets you control the balance between keep and drop colors, 
based on the area you are working on. For example, you may want the Perfect Brush to be 
very precise and only paint away very similar colors, while at other times you want it to paint 
away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To create a 
soft edge, increase the transition. To create a harder edge, decrease the transition amount.

Manual Spacing

When checked, this sets the spacing of the brush tip as you apply a stroke. This is primarily used when 
painting with custom brushes. See “Using Custom Brushes to Add Overlays To Photos” on page 113 for 
information on how to use this setting. 

Pressure options

ON1 Effects supports pressure-sensitive tablets with the Masking Brush. You can enable pressure sensitive 
controls for the brush size, brush opacity, or both simultaneously. To turn this support on, click on the gear 
icon in the Tool Options bar. You can activate pressure sensitivity for both size and opacity by clicking the 
appropriate buttons in the drop-down menu.

GRADIENT MASK

The Gradient Mask is used for blending masks and layers by creating radial, gradient and 
reflected gradient mask shapes. The mask goes from dark to light in tone, applying more of 
the adjustment where the gradient is lighter, and less of the adjustment where the gradient’s 
tone is dark. The most common use of gradient masks is to darken the sky in an image, while 

preserving the brightness of the foreground, similar to using a gradient filter on your camera lens, or to 
adjust the effect of a filter mask in Effects.

To apply a standard gradient to a filter in Effects, a local adjustment, or a layer, click on the Gradient Mask 
in the Tool well, then click in the image roughly where you wish the gradient to go. You’ll see the outline 
of the gradient, which is called a bug. You can use the handles on the bug to move your gradient around, 
increase or decrease the length of the gradient, or rotate it. You can also create (and delete) multiple 
masking bugs.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.
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Gradient Mask Tool Options

• Preset: The preset pop-up includes six settings for the bug’s mask (vignette, strong vignette, 
top down, bottom up, and linear left and right), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum density of the mask.

• Color Range: When enabled, this detects the color under the gradient and applies the mask 
to only that color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a gradient mask

Once you’ve added a gradient to an image, you can 
modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle 
at the center of the gradient and drag.

• To resize a radial gradient, click and drag on 
the solid line.

• To adjust the feather (or hardness) of the 
mask, click and drag along the dashed line.

• To rotate the mask, click on the smaller 
circle near the center of the gradient and 
drag it up or down.

Working with multiple masking bugs

You can have up to six masking bugs per layer. Each bug is re-editable. To add another masking bug, press 
the Add button or click outside of the current bug while the Gradient Mask tool is selected.

Only one masking bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

The Preset (left) and the Shape (right) options for the 
Gradient Mask tool.
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Masking bugs are subtractive. Each bug hides more and more of the current layer. When masking bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint back in areas hidden by the masking bugs.

QUICK MASK AI BRUSH

The Quick Mask AI brush is functionally similar to the Super Select AI tool, but it is intended to 
create selections for the current filter, local adjustment, or layer — all it does it create a mask 
for that item. It does not create a new filter pane or local adjustment layer.

To use the Quick Mask brush, first create a filter in Effects, a local adjustment layer in the Local Tab, or the 
master layer mask, select the tool, and move your cursor over the photo. As you move around the photo, 
Effects will display the various regions in your photo as red overlays; clicking on a region will create a 
selection and change the overlay for that area from red to blue. If there are additional regions you wish to 
select, hover over the new area and click. To remove a selection, click on it a second time.

The Quick Mask AI Options bar has two options: Paint or Erase. Paint will apply white to the mask you 
create, while Erase will apply black to the mask. Clicking the checkmark button will create the mask and 
select the Refine Brush so you can fine-tune the mask.

While the masks created by the Quick Mask tool are generated automatically, they function like any other 
mask created in Effects. This means you can use the other masking tools to adjust and refine the finished 
masks. This also includes the Mask Control options found in the Masking tab of the Properties window (see 
“Mask Options and the Refine Mask menu” on page 62).

The Quick Mask AI brush is designed to be used when you have created a filter pane in Effects, a local adjustment in the Local tab, or a separate 
layer. Here, a Dynamic Contrast filter has been applied to this image. 
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Quick Mask AI Brush Options bar

• Mode Selector: Paint applies white to the mask; Erase applies black to the mask.

• Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

• Done: Creates the mask and selects the Refine brush.

QUICK MASK BRUSH

Powered by machine learning, the Quick Mask brush creates high-quality masks with just a 
few strokes. To use it, you paint areas you want to keep in green and areas you want to drop in 
red. Effects analyses the color, tone and texture of the marked regions to learn what you want 
to make out and then automatically finds the edges and creates the mask for you. Use it with 

layers to replace skies or with filters to selectively apply them. 

You can use this tool on a filter in Effects, a local adjustment, or on a layer. If you wish to use it on a filter, 
to mask some of the filter’s effects out of your photo, add the filter in Effects, and select the Quick Mask 
Brush. To use it on a layer, select the layer. In both cases, you’ll follow these steps:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green. 
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2.	 Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD. 
This will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the 
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve 
the results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 
Effects switches to the Refine Mask tool.

Once you click on the Done button, Photo RAW will create the finished mask (shown here as a red overlay), applied to the 
current filter. You can manipulate the mask further with any of the refine mask tools.
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Quick Mask Brush Options Bar 

• Mode Selector: Paint means that the mask will be applied to the selection; Erase means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Brush Size: Controls the size of the brush. Use a small brush at high magnification for precise 
work, and a large brush at fit to screen for general work.

Further settings for the Quick Mask brush can be found by clicking on the gear icon in the Tool Options bar. 
There, you can set the following options (shown right): 

• Pressure Adjusts Size: This option lets you control the size of the brush using a pressure 
sensitive tablet. The harder you press, the larger the brush becomes up to the current setting 
of the size slider.  

• Refine Edge: Applies the Refine Mask brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This the default 
and is recommended for most photos.

• Show HUD: This displays the Quick Mask Brush’s 
HUD dialog, which provides guidance on how to 
use the tool.

• Overlay: Sets the transparency of the red and green 
mask overlays on top of your image. A setting of 
100 displays only the mask; the default is 50.

LINE MASK TOOL

The Line Mask tool lets you create masks by 
drawing straight lines in your image, with the 
added flexibility of letting you adjust each 
individual line segment into curves to better 

fit the object you want to mask. Masks created with this 
tool are re-editable, can be copied and pasted like any 
other mask inside Effects, and you can have multiple Line 
Mask selections for each mask. 

To start, you click and drag along the outline of the area 
you wish to mask. Clicking your mouse button (or with a 
pen and tablet) adds a point to the line; you can continue 
to click along the edges of your desired selection, and 
the tool will add points along the way. These points will 
be represented by a small square. When you’re finished, 
hover your cursor over the first point and click on it to 
close the path created by the tool. This will close the 
selection and change the cursor to a paint bucket icon; 
click inside the area and Effects will create and the display the mask. 

The Quick Mask Brush HUD gives displays instructions for 
using the tool. You can turn the HUD off via the Gear menu 
in the tool options bar.

When you complete the mask area by clicking on the original 
point, the cursor will change to a paint bucket icon. Clicking in the 
area will generate the mask..
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Once you’ve closed the mask, you can adjust the feather and opacity of the mask, and you can further 
adjust the points on the line in the following ways:

• You can click on any point in the selection and move it by dragging it.

• If you hover (or click) on a point, you’ll see a circle appear between that point and the 
previous point on the line. This circle can be dragged in all directions to curve the line to 
better fit the object you are masking.

• Add a point by holding down the Shift key and clicking on the line.

• You can delete any point by right-clicking on it and choosing Delete Point from the pop-up. 

• You can delete the entire mask by choosing Delete Line Mask from the pop-up menu.

While you’re creating the mask, the curve option is always available for the current point; move the cursor 
back over the line before the point and the circle will appear. You can then drag the curve in or out, and 
when you’re done, move the cursor and click on the next place you wish to add a point.

When you’ve made your adjustments to the selection, you can click the Done button in the Tool Options 
bar to quit the tool, or you can create another mask. 

To re-edit the mask at a later time, select the filter, layer, 
or adjustment layer that has the mask attached to it and 
choose the Line Mask tool. When you move your cursor 
over the area that contains the mask, the mask’s outline 
will appear in light blue. Click anywhere on the outline, 
and the mask’s points — both square and circle — will 
appear, and you can adjust it as you see fit, even the 
Opacity and Feather settings.

Line Mask Tool Options Bar

• Mode Selector: Paint means that the mask will be applied to the selection; Erase means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Opacity: Controls the opacity, or transparency of the finished mask, from 1 to 100 percent. 
At 100 percent, all of the effect will be displayed in the mask area; as the opacity level drops, 
more of the layer underneath the mask will be visible.

• Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100; 
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that 
‘feathers’ the transition between the masked and unmasked boundaries. 

• Delete: Removes the currently selected line mask.

• Done: Saves the current line masks ad closes the tool, returning to the View Tool.

The curve option—visible when you hover over a point in the 
selection—lets you fine tune the line to make it better fit the 
object you’re masking. (Shown here exaggerated for effect.) 
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REFINE BRUSH

This tool, one of the most versatile in Effects, can be used to clean up intricate areas and the 
borders along a mask. It is helpful for cleaning up a mask created with the Masking Brush, the 
Super Select AI tool, or other masking tools, or for creating a new mask entirely. 

When you paint with the Refine Brush, the brush strokes are displayed as a red overlay, and when you let 
up off the mouse button, Effects will work to make the mask edge better defined. 

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which refines to remove from the 
mask, Paint In, which refines to add to the mask, or Auto, which determines the best way to 
refine the mask edge. Paint Out is recommended in most cases.

• Size: This adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results. You can use your mouse’s scroll wheel to 
adjust the size of the brush as well (see “Using Effects with a Scroll Wheel” on page 21). 
The Refine Brush’s maximum size is 500 pixels.

• Method: Lets you choose the refinement algorithm and settings 
based on the subject of the masked area. There are five method 
types, plus a user-defined setting that is created when you adjust 
any of the individual parameters found in the Gear menu:

• Original: Uses the refinement algorithm found in earlier 
versions of Effects (referred to as Mode 1 in the gear menu).

• Hair/Branches: Optimized for fine detail, like hair, branches 
and other subjects.

• Hard Edges: Best method for refining masks with distinct 
edges between masked and unmasked areas.

• Diffuse Edges: Works best on areas where edge detail is 
not as well-defined.

• Noisy Images: Works well on photos that have higher 
degrees of noise in them.

The Gear menu includes a setting for controlling the size of the Refine 
Brush with pressure. It also can be used to adjust any of the refine methods 
in the Method menu. The parameters include:

• Mode (1 or 2): As noted above, Mode 1 is the Refine Brush 
algorithm used in previous Effects versions; it remains useful in 
many masking situations. Mode 2 uses the new (2024) version of 
the Refine algorithm. 

The Method pop-up.
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• Sensitivity (0-100): Refers to the edge sensitivity; low for diffuse edges, high for hard edges. 
(Works only with Mode 2)

• Locality (0-30): This parameter varies the search for similar scene materials; higher values 
expand the search zone along the brush edges. (Mode 2 only)

• Smoothness (0-100): Represents post-processing smoothing of the refine results. Higher 
numbers mean smoother edges. (Mode 2 only)

• Noise (0-100): This is a post-processing-based noise filter; use higher values with noisier 
images. (Works with both Mode 1 and 2)

When you change any of the parameters in the Gear menu, those results will be applied to the User 
Defined settings, and will be saved until you change them again. In general, however, most of your masking 
refinement work with the Refine Brush should be found in one of the five primary Method options.

Working with the Refine Brush

One of the biggest issues with masks is the transitions between edges, or in areas where one of the  
primary masking tools will miss some fine detail. You’ll notice these transitions when you apply an effect or 
adjustment to a masked area, and there will be halos on the mask edges, or areas where the effect should 
be applied, but isn’t. The Refine Brush, and, on occasion, the Chisel and Blur tools, can be used to help you 
fine-tune your masks and better transitions, ultimately creating more realistic masks. 

The Refine Brush is often the first place you’ll want to go when working with masks that could use some 
tuning. Some of the most common operations include:

• You can paint along the edges of a mask that might have areas where the mask isn’t complete, 
or where the transitions between masked and unmasked areas could be smoother. 

• You can paint over large areas of a masked area where there might be fine edges that could 
use further refinement, like trees or hair.

• You can also “encircle” an area in a photo where you wish to add to or subtract from a mask, 
or even create a new mask altogether. 

For simple areas where you wish to refine an edge that has some halos or is otherwise a bit less than ideal, 
set the brush size a bit larger than the area you wish to tune set the appropriate method, and brush over 
the edge. This is shown in the enlarged area below. 

In the photo above, a local adjustment on the sky, masked with Mask AI, left some ugly halos along a treeline. Using the Refine Brush, set to the 
Diffuse Edges method, smoothed the transition properly, making for a better mask. (Effect exaggerated for demonstration purposes.) 
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With tree branches, hair and other areas of fine detail, you can paint over the entire area that you wish the 
mask to refine, as shown in the following graphic.

The Refine Brush’s “encircling method” lets you add to or subtract from an existing mask, or you can use it 
to create your own mask. To do this, use the brush to draw an outline 
around the object you wish to select and mask. What happens next 
depends upon what your intent is, and whether there is already a mask in 
the local adjustment or Effects filter you are currently working with:

• If there is a mask already created, and you wish to remove the 
stroked area, choose Paint Out before applying the brush. If you 
wish to add to the existing mask, choose Paint In.

• If there is no mask already present in the adjustment or filter, 
using the Refine Brush and drawing around an object or area 
will create a mask of the encircled space.

For more information about masking inside Effects, see “Masking Basics” 
on page 58. 

CHISEL BRUSH

The Chisel brush works to remove fringes or halos along the hard edges of a mask; just 
click and drag along the edges of a mask you wish to refine. Fringes are common when the 
background to be removed is brighter than the foreground. The chisel works like a chisel or 
plane in a wood shop: It removes just a sliver along the edges, and, because it only works on 

the edges, you don’t have to be too careful when using it.

Chisel Brush Options

• Mode: Select remove or add from the mask edge

The Refine Brush is a great choice for adjusting masks with fine details that are often obscured when building masks with some of Photo RAW’s 
primary masking tools. In the screen shots above, you can see the mask of a tree generated automatically with the Mask AI pop-up in a local 
adjustment layer (left). The tree’s interior branches are completely masked. Selecting the Refine Brush, with the Method set to Hair/Branches, 
we’ve painted broad strokes in and around the area where the branches are (center). Photo RAW then refines the mask so that the branches are 
properly masked against the sky, making for a much more realistic mask.

The encircling method.
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• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-clicking on the Chisel icon applies the chisel to the entire mask.

BLUR BRUSH

The Blur brush softens edges of the mask where you paint; all you need to do is run the tool 
over the edges you wish to blur. Softening the edges on blurred or semi-transparent subjects 
like hair can make them blend with a new background in a more realistic manner. 

Blur Brush Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur icon applies the blur to the entire mask.
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Retouching Tools
The Retouch tool group has a four tools, the Healing Brush, Prefect Eraser, Retouch Brush, and Clone 
Stamp, each of which have different options for removing distractions from your photos. The Healing Brush 
is the only non-destructive tool in the group, which means that you can adjust each individual application of 
the tool at any time. The remaining tools are destructive, in that you cannot remove individual operations, 
although you are able to reset all retouching operations from the Settings menu (see “Resetting edits” on 
page 72).

HEALING BRUSH

The Healing Brush is a tool for removing distractions like dust spots, power lines and unwanted 
people from your photos, using sophisticated content-aware fill technology. Like the other 
retouching tools, you can apply the brush to multiple portions of an image. Unlike the other 
tools, however, the Healing Brush is fully non-destructive: each area you apply the brush to is 

individually editable (and removable).

To use the brush, paint over 
a distraction and a matching 
area of your photo will be 
blended on top to replace 
it, using content-aware 
technology. You’ll see two 
circular markers: red, which 
is the area that has been 
removed, and green, which 
is the area that was used to 
fill the source. Each marker 
is movable by clicking and 
dragging; sometimes, you’ll 
want to try a different area 
to match to your source. 
Non-active markers will be 
displayed as gray squares 
until you click on them. (Press 
the Delete key to remove the 
current area.)

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

• Heal mode applies content-aware matching from a nearby area to mask the object or area 
being painted out.  

• Stamp mode acts like the Clone Stamp tool (see page 57), applying the actual pixels from 
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

• Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or 
object instead of masking it out.

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a specific marker will 
display the source and area used to fill the source. You can then readjust its placement, or delete the area.
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• Move mode is similar to Copy mode, except that it masks the brushed area and moves the 
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the 
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the 
new mode, and re-brush the chosen area.

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: sets the type of healing that will be applied when brushing — Heal (content-aware), 
Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

• Overlay: Sets the display of the markers designating retouched areas. Auto displays all the 
markers in the photo, with the current marker highlighted in red and green, and the others as 
gray. Selected will only display the current marker (in red and green); the other markers will 
only be visible as you move over the photo with your mouse.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots 
more easily.

• Pressure Adjusts Size (gear icon): If you have a pressure-sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.

Transforming retouched areas

As noted, all applications of the Healing Brush are 
non-destructive, meaning that you can adjust the 
source and destination areas for each marker, and 
you can delete markers by clicking on the appropriate 
market and choosing Delete from the Tool Options 
bar (or by pressing the Delete key).

You can also transform individual destination markers 
in a photo by holding down the Option/Alt key (Mac/
Windows) and hovering over the area. When you do 
this, a box will appear over the currently selected 
destination marker. You can resize the selection 
by adjusting the handles on the box; to resize 
proportionally, hold down the Shift key. You can also 
rotate the selection by clicking outside the box and 
pressing the mouse key, or you can flip the selected 
area vertically or horizontally by clicking the icons 
underneath the box.

When you hold down the Option or Alt key and hover over the 
currently selected Healing Brush marker, a box appears, which lets you 
adjust the size, rotation and orientation of the marker. When used in 
conjunction with the Healing Brush’s Copy or Move modes, you can 
easily duplicate and transform individual subjects within your frame, 
as shown by the copy of the pronghorn above..
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PERFECT ERASER

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. 
It uses a content-aware algorithm that replaces the pixels with a natural-looking result within 
the boundaries that are painted. It also has specialize options for automatically removing dust 

spots and power lines from a photo.

Use the tool to paint over an area you wish to remove, covering the entire area. A red overlay appears 
where you paint. If the first attempt does not give you a perfect result, paint over it again and it will 
improve with each pass. You can also fine tune the area after by using the Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of five options; brush size, buttons for removing dust and 
power lines, a dust-spot overlay, and pressure-sensitive tablet support.

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking 
on the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. 
The maximum brush size is 500 pixels.

Clicking the Reduce Dust button will automatically scan the current photo for dust spots, removing obvious 
ones from the photo. By default, the Reduce Dust operation does not act aggressively, so as not to remove 
some items that might be questionably be dust or natural phenomenon. This means you might still find 
some dust spots in your photo.

Clicking the Reduce Power Lines button will scan the current photo looking for clear examples of power 
lines, and will remove them from the scene.

The Visualize Dust item displays a high-contrast overlay to help find and eliminate sensor dust spots. 

If you have a pressure-sensitive tablet, select the Pressure Adjusts Size item, which is in the gear icon. 
The gear icon also includes a Legacy option, which is solely used to preserve compatibility with previous 
versions of Effects.

GENERATIVE ERASER

The Generative Eraser uses ON1’s Local Gen AI technology to remove larger distractions from a 
photo than can be removed with the other retouching tools. 

Use the tool to paint over the areas you wish to remove, covering the entire area of the object. A 
red overlay appears where you paint. When you have painted over all the areas you wish to have removed, 
click the green Generate Content button in the Tool Options bar. Effects will analyze the areas and replace 
them with seamless areas that fit into your photo.

When you use the Generative Eraser, Effects creates a new layer with all of the changes you make. When 
you close the file and return to Browse, your file will be saved in the .onphoto format; your original image 
remains at the bottom of the layer stack.
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Generative Eraser Options

• Brush Size: Adjusts the overall brush size of the eraser.

• Mode Selection: The Generative Eraser defaults to Paint, which you use to paint over the 
subject that you wish to remove; use Erase before you generate content to refine a subject 
selection, or to remove that subject completely from the removal process.

• Distractions: Selects all of the people, wires or vehicles in a photo. 

• Quick Mask AI Brush (puzzle icon): Select regions in a photo for removal using the Quick 
Mask AI Brush. Click to invoke the tool, then click the puzzle icon to add the selections to the 
current grouping (see page 28 for the specifics of using this brush).

• AI Model (gear icon): Selects the Local Gen AI, Local NonGen AI, or Stability AI model.

• Generate Content: Removes the selections and replaces them with generated content. The 
button then changes to Retry if you wish to try again. (The Undo command will step you back 
to the selection group, if you wish to adjust your selection.)

There are three additional options, Clear, Cancel and Apply, which can be found 
on the far right of the options bar. Clear wipes out the current mask (objects 
selected for removal). Cancel quits the Generative Eraser session without 
applying the generated content (if you had generated it) and selects the Zoom 
tool. Apply applies the generated content and saves it to a new layer in the current photo.

You can use a combination of tools to select multiple objects for removal. For example (shown below), you 
could use the Distractions option to select all the people in a photo; click the Erase button and paint over 
any people you with to keep in the scene; and use the Quick Mask AI Brush to select additional objects for 
removal. When you’re done, click the Generate button to perform the removal. 
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RETOUCH BRUSH

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

• Pressure Adjusts Size (gear icon): Click on the button to activate the sensitivity controls for 
your pressure-sensitive tablet.

CLONE STAMP

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

• Pressure Adjusts Size (gear icon): If you have a pressure sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.



ON1 Effects 2026 User Guide	 Part 2: Working in Effects	 58

Masking Basics
One of Effects’ most powerful features is its masking 
capabilities. Every filter in Effects, every adjustment 
panel in the Local tab, and every layer can have a mask 
associated with it. And, when you’re retouching a face 
in Portrait AI, that face has had a mask automatically 
generated for it.

At its simplest level, a mask shows or hides the effect 
of the filter or adjustment. Masks have no color: they 
are grayscale, and the tones range from pure white to 
pure black. A mask that is completely white displays 
the entirety of the effect being used, a mask that is 
completely black hides that effect. (A common way to 
remember it is via the phrase “black conceals, white 
reveals.”) Shades of gray are in effect the opacity of the 
mask. Darker shades reduce the effect, lighter shades let 
more of it through.

The beauty of the masks is that you can paint with 
black, white or any shade in between, so you can “mask” 
portions of your photo so that they will not have that 
effect—or will have a reduced effect. You can also copy 
masks from one filter and past them into other filters. 
Using this feature, you can mask out the sky in one 
filter, copy the mask, paste it into another filter and 
invert it, applying a different effect to everything but 
the sky. Effects even lets you create luminosity masks, 
which are masks that are solely based on the brightness 
of the pixels in the image. And, while working on your 
images, you can press the ‘O’ key and view your masks, 
either as a red overlay or as the grayscale version of 
the actual mask, which can be helpful when you wish to 
check the edges of mask, or want to make sure an area is 
completely masked.

Creating masks can be as simple as choosing the Super 
Select AI tool and clicking on a region in a photo; using 
the Mask Sky option from the Mask menu; or dropping 
a gradient on a photo. You can also create complex 
masks by using multiple tools and masking functions. For 
instance, you can drop a gradient on a photo, and use the 
Masking Brush to paint out areas where you don’t want 
the gradient applied, or you can use the Color Range 
function (in the Masking tab of the Properties window) to 
select portions of an image based on specific colors and 
tones. 

Three views of a mask (A-C), along with the Masking 
Options section of the Properties window, here shown 
attached to a Sunshine filter. When you first add a filter 
(or a layer), the mask is empty (A). If you click on the 
empty mask, Effects will automatically generate the 
mask, here shown filled with white (B), which means all of 
the effect will come through. When you use any of the 
masking tools, the areas masked out, will be shown in the 
filter’s mask view (C).  
 
And, when you click on the mask icon in the pane, it will 
open the Properties window (D), which includes options 
for displaying, copying and pasting, and fine tuning that 
mask. Masks can also be created from within the 
Properties window. (If you have Properties set to be 
nested in the left or right panels, it will be opened there.)
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CREATING MASKS

There are multiple methods for creating masks inside Effects, and it can be as simple as:

• Clicking on the Subject, Background, Sky, Luminosity or Depth button in the Masking 
Properties window (or the More menu), each of which build a mask with a single click.

• Choosing the Super Select AI tool, then clicking on regions in a photo to build a local 
adjustment layer or to add an Effects filter. (See page 38.)

• Using one of the other masking tools — the Masking or Quick Mask brushes, or the Quick 
Mask AI, Gradient Mask or Line Mask tools. (See page 40.)

• Using Effects’ Mask AI technology via either Effects’ Add Filter window, a new local 
adjustment, or the Masking Properties window, to select specific regions in a photo. (See 
page 60.)

Many of the masking options can be used in conjunction with one another to create complex masks, adding 
to, subtracting from, or intersecting with the current mask. In addition, Effects includes a group of three 
refine brushes—Blur, Chisel and Refine—which are designed to help work with edges and halos that can 
crop up when you have areas of strong contrast between a masked area and an unmasked one.

Each mask you create has a set of controls you can use to manipulate the mask to adjust it further (see page 
62 for more). 

When you add an Effects filter or a layer to a photo, the mask is technically hidden. You can create a mask 
by either using one of the masking tools, or by clicking the Show/Hide Mask icon in the title bar of the 
pane, to the right of the filter or layer name. The contents of the Show Mask icon will represent the mask 
on that layer. Local Adjustment layers automatically create a black layer mask, so you can ‘paint in’ the 
adjustment to the image.

Here is a local adjustment—created using the Sky masking option in the Masking Properties window—that has been applied to a photo to lighten the 
sky. The Show Mask option has been turned on, so you can see where the effect has been applied (shown in red). 
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Mask overlays

Effects has two primary options for viewing the contents of a mask: either as a red overlay on top of your 
image, or a view only of the mask itself, represented as grayscale. You can turn the mask overlay on or off 
by pressing the ‘O’ key on your keyboard. 

The grayscale view can be helpful when checking edges, or when refining some of the advanced masking 
controls. These mask view options are available from the Mask menu; select Show Mask to see the mask, 
while the View Mode option lets you switch between the two modes.

When you’re viewing a mask in either overlay or grayscale modes — or even when you aren’t actually 
viewing it — you have access to all of the tools in the Edit module. You can zoom in, to view the mask in 
greater detail, can use the Refine masking tools to adjust the fine edges of your mask. You can also use any 
of the other masking control options found in the Refine Mask window, as described on page 62.

If you choose the Color Overlay when Brushing option from the Mode pop-up, Effects will only display the 
overlay when you are brushing with the Masking Brush, or are modifying the Gradient tool.

You can change the default red overlay color by clicking on the color swatch next to the Opacity slider.

MASKING PROPERTIES

The Masking tab of the Properties window is the masking 
control center. It has the following contents:

A.	Mask options for one-click creation of masks, 
including subject, background and sky selection, 
as well as luminance and depth masks. The More 
button includes additional masking options, 
including all of the conventional masking tools, 
color range options, and Mask AI regions.

B.	 The Target Mask section is a grayscale 
representation of the current mask. When you use 
multiple masking tools or options, the target mask 
displays the composite mask of those additional 
mask layers. 

C.	 Mask Layers displays the different mask layers that 
make up the target mask.

These screen shots show a cross-section of the image above, with the lightened sky adjustment layer. From left, (A) the original image,; (B) a red 
overlay displayed after the sky mask was added; (C) the overlay, in grayscale mode; and (D) without overlay, the brightening effect is visible.
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D.	Overlay Options includes settings for how the mask overlay is represented. You can adjust 
the opacity of the mask (lower displays more of the underlying image, higher displays less), 
the type of overlay (Color, Color while brushing, or Grayscale), and have overlay display either 
the masked area (affected) or the unmasked area (Non-Affected). 

The Mask creation options include buttons for:

• Subject: creates a mask of the image’s subject.

• Bkgrd: creates a mask of the image’s 
background.

• Sky: creates a mask of the sky.

• Lumin: creates a luminosity mask of the image (see page 64). 

• Depth: creates a depth mask of the image (see page 63).

Clicking the More button provides additional mask creation and adjustment 
operations. In addition to the five one-click mask options, including:

• Color Range, which lets you choose a color and make or tune the mask 
based on the range of the color selected (“Color Range selections” on 
page 65).

• The Quick Mask AI Brush for selecting regions (page 44)

• The Masking Brush (page 40).

• The Gradient Mask tool (page 42).

• The Line Mask tool (page 47).

• Mask AI regions (see below).

Additional masking options: Add, Subtract and Intersect

For all of the items accessible via the More pop-up menu, you have three masking operations — Add, 
Subtract, or Intersect — available when you choose one of the options in the menu. Each of these options 
creates a new mask layer for the current filters, adjustment layer, or photo layer.

Add creates a new mask layer. If a mask doesn’t already exist for the current filter or adjustment layer, this 
new mask is represented in both the Target Mask section as the composite mask, and as the sole Mask 
Layer. If a mask already exists, it will be added to the top of the Mask Layers section, and the Target Mask 
will updated with the new mask.

Subtract is similar to Add, but is used to remove pixels from the active mask areas.

Intersect will create a new mask layer that only applies to the masked areas that overlap between the 
current mask layers.

Using Mask AI to select regions

Mask AI is ON1’s underlying technology for AI-based object and region selection. It is what powers the 
Super Select AI tool, but it is also found inside the Masking Properties window and the Add Filter window 
in Effects (see “The Filters Window” on page 81).
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When you choose Mask AI from the More menu in Masking Properties, Effects scans the photo and builds 
a list of the known regions and displays them in the new mask layer. Clicking on one or more of the regions 
will display a mask overlay (in blue) of that region; clicking the Apply button will create the final mask, and 
you can use the Feather slider to blur the edges of the mask if needed.

Mask Options and the Refine Mask menu

If you hover over a mask’s title bar in the Target Mask section of the properties window, you’ll see a 
‘hamburger’ icon, represented by three vertical lines. Clicking on the icon will display a set of additional 
operations you can perform on the mask, including:

• The Refine Mask command, which 
gives you a set of controls for 
adjusting mask parameters.

• Invert, which inverts the current mask.

• Disable/Enable, which turns the mask 
off and on. (Label changes to Remove 
when working on a mask layer).

• Reset removes the current mask, 
turning it to white when used with a 
layer mask or a filter mask, and black 
when used with a local adjustment.

• Copy makes a copy of the mask, for times when you wish to add another filter or local 
adjustment using the same mask.

• Paste pastes the copied mask.

Selecting Mask AI from the More menu will create a new mask layer, with a list of the found regions in the photo. Hovering over the labels will show 
the region in blue. Clicking on one (or more) of the regions will add that region to the mask layer (above left); click Apply to generate the final mask, 
and use the Feather slider to blur the edges of the mask, if desired.
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Copying and pasting masks is only available when working with the target (composite) mask. 

Choosing Refine Mask from the Mask Options menu calls up the Refine Mask window, which has a set of 
controls for adjusting the mask:

• Density adjusts the overall density 
from black (100) to white (0).

• Feather blurs the edges of a mask.

• Levels adjusts the black point, white 
point and gamma of the mask.

• Shift Edge increases or decreases the 
mask in small amounts, to help reduce 
halos.

• Window creates a window of tones 
between the slider handles, and 
works well when adjusting luminosity 
masks. The set of tones with numbers 
underneath the Window slider simulate the Zone system, and is designed to help you pick the 
desired tones for refining.

The Feather and the Shift Edge sliders are good for smoothing transitions between masked and unmasked 
sections; depending on the masks and the images in question, one might work better than the other. 
Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it like a ‘reverse 
fade’: at 100, all of your mask is viewable, at 0, the mask is entirely white.

DEPTH MASKS

Depth masks utilize powerful AI models to infer 
the depth within a scene, with the capability to 
blend or apply adjustments or effects based on 
the scene’s depth. This mask type makes effects 
like lens blur and other adjustments more 
natural. 

When you click the Depth Mask icon, Effects 
builds a mask based on the depth of the scene in 
relation to the camera. When you look the mask, 
you’ll see white areas are those closest to the 
camera, and black areas are those furthest away, 
with gray tone for the distances in between. 
Those areas closer to the camera will have more 
of the adjustment applied, while those further 
way will have less (or none) of the adjustment applied. 

You can adjust the depth by clicking on the mask (in the Mask Layers section), and adjusting the Distance 
slider.

The depth mask for the photo above is shown on the right. Lighter tones are 
the areas closer to the camera, while darker ones are further away.
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You can use the Refine Mask options to manipulate the mask, to add or remove tones from the effect, and 
the Invert Mask button can be used if you want to reverse the depth effect.

LUMINOSITY MASKS

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Effects. 
This mask uses the brightness (or luminance) values in your image to let you target specific tonal ranges 
with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very specific 
areas of an image. They can be used for targeted sharpening and contrast operations, highlights control, 
and much more.

To add one of these masks, click on the Lumin button in the Masking tab or choose Create Luminosity Mask 
from the Mask menu. Because luminosity masks take the brightness levels of a photo, when you view the 
mask, it will look like a grayscale version of the image. With a luminosity mask, your effect will be applied 
in an increasing amount depending upon the brightness value of the pixel underneath: if the pixel is black, 
none of the effect will be applied; if it is white, it will be entirely applied; for all other tones, the effect will 
get applied as a percentage of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

Viewing a luminosity mask is similar to a black-and-white version of your photo; the lighter the tones, the more the intended effect will be, and the 
darker the tones, the lesser the effect.
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COLOR RANGE SELECTIONS

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of colors will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Masking 
Properties. When you add a gradient mask and click on the Color Range option in the Tool Options bar, 
the color chosen is sampled from the center of the gradient control, but you can open the Masking section 
of Properties and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug.

MASKING TIPS

Here are a few tips for working with the various masking options:

• You can use multiple masking tools to create, modify and refine masks. For example, you can 
start with a luminosity mask, adjust the tonal range of the mask with the Levels or Window 
sliders, and then further refine your mask by painting in or out with the Masking Brush or 
Gradient Mask. Adding a luminosity mask always overrides the current mask (as is the case 
with the Quick Mask AI brush), however, so you should start there.

• While the AI-based masking tools can be quite good when building selections, they aren’t 
perfect. You should inspect your AI masks after applying them, and use the other masking 
tools, or the Refine, Chisel or Blur masks, or the masking options to fine-tune your selections.

Here, we’ve created a mask using the Color Range option in the Mask Options section for this Color Enhancer filter in Effects. 
We clicked on a blue color in the sky to use as the base for the selection range. Adjusting the Color Range slider while viewing 
the mask lets us fine tune the selection.
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• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at 100, all of your mask is viewable, at 0, the mask is entirely white.

• Don’t forget that masks aren’t just for Effects filters and Local Adjustments; they can be 
extremely helpful when you’re working on multiple layers of the same photo. 

• It can sometimes be helpful to use the same mask on different filters, so use the Copy button 
to grab the contents of a mask from one filter and the Paste button to paste that onto the 
mask of another filter. The Paste Invert command can be invaluable when you wish to apply a 
filter to the opposite portion of a photo, such as a sky and your foreground.

• Because masks are tied to the actual pixels of the current photo (or layer), they cannot be 
copied from one photo to another, or between layers in a multi-layered document.
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Presets
Presets are stored “recipes” that include sets of Effects filters and local adjustments, and can be applied to 
a photo with one click. Presets are a fast way to get consistent results when editing a group of images, 
helping you hone your own look. You can also create your own presets, even presets that incorporate 
ON1’s Mask AI technology to apply masks automatically to regions in a photo (See “Creating and Using AI 
Adaptive Presets” on page 70).

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of presets. (The 
view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various presets, with a thumbnail 
of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name. Clicking on that icon will open a full-screen 
window showing your photo with that category’s presets applied to it. (See the following page for a screen shot of the Quick View Browser.
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ON1 Effects 2026 comes with more than 200 built-in presets, in more than a dozen categories, ranging 
from landscapes to portraits, color grading, film looks and much more. You can create your own presets, or 
import presets from other ON1 users and photographers.

Presets can also store crop settings and retouching information, as well as masks created with brush tools, 
Effects’ Masking Bug, and the Adjustable Gradient Tool in the Local Adjustments panel. If you apply a 
preset that contains these options, you should check to make sure that you have the desired result; if not, 
you can reset the various individual operations via the Settings menu. 

APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1—ordered by category—as well as any presets you might have created or installed yourself. Clicking on 
a category name will open it and display any presets within that category, with a tiny thumbnail showing 
your selected image with that preset applied to it. To change the size of the thumbnails in the Presets panel, 
select the Browser Mode option from the View menu and choose One, Two or Three Column View.

To help you view the effects of a specific preset, Effects will 
display a real-time representation of that preset over your current 
photo when you hover your cursor over a preset in the 
subcategory view. To see a larger representation of what your 
selected photo will look like with all of a category’s presets, click 
on the Quick View Browser icon in the title bar. That will display a 
window with all of the presets in that category. (Press the Escape 
key to close the Quick View Browser.) To apply a preset to a photo, 
click on the preset in the mini-browser or in the Quick View Browser. Presets are not cumulative; clicking 
on another preset will remove the previous one and apply the new one.

The Golden Autumn preset category, with the 
Quick View Browser icon shown on the right.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from 
the Window menu) will open a full-screen representation of that category’s presets, giving you a larger 
representation of how that preset will look on your image.
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Once you’ve applied a preset, you can reduce its overall effect by hovering over the preset name, which 
displays the Fade slider. This lets you lower the opacity of the Effects filters 
applied with the preset. 

After you have applied a preset, you can still make changes to any of the settings, 
add or remove adjustments, switch to another preset, perform retouching 
operations or more. 

If you don’t like a preset, clicking on another one will replace the settings of the 
previous preset with the settings of the new preset. To remove a preset entirely, 
choose one of the reset options from the Settings menu, or remove the individual 
settings from the appropriate panes in the Effects and Local tabs. 

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting Presets (Effects tab only)

When you click on a preset, Effects’ default behavior is to remove any existing adjustments and apply the 
newly chosen preset to your photo. Sometimes, however, you would 
like to add a preset on top of your adjustments. To do this, open the 
Presets pane, right-click on the preset you wish to add, and choose Insert 
Preset from the pop-up menu. This will add the preset’s filters above the 
currently selected filter pane and will preserve any edits in the Local tab. 

Inserting a preset will only add that preset’s Effects filters to your 
currently edited photo. Local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that 
you wish to save, go to the Settings menu and 
select Save Preset. The Save Preset dialog will 
appear, with options for which module’s settings 
you wish to save, naming the preset, and adding 
it to an existing or new category. Nearly all 
of the Edit module settings can be saved as 
a preset, including cropping, retouching, and 
masks. To save your masks — AI adaptive or 
otherwise — check the Apply Masks option for 
each tab in the Edit module. 

If you have applied a preset to an image, and 
subsequently updated any of the edit settings 
(or add or remove adjustments), you can update 
the preset with the new settings by choosing 
Update Preset with Current Settings from the 
Settings menu. This will only change the preset in your app; any images that had the old version of the 
preset will keep those settings unless you reapply the preset. (You can also update a preset by right-clicking 
on the preset in the Preset Browser.) 

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset.

The Save Preset window includes all of the operations possible in Effects. 
Filled circles to the left of a setting mean that the setting will be saved in the 
preset; click the circle if you don’t wish that setting to be saved.
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If you would like to create a new preset category—which will be added to the Presets panel throughout 
ON1 Effects—choose Add New Category from the category pop-up. 

CREATING AND USING AI ADAPTIVE PRESETS

When you use the Super Select AI tool or the Mask AI options in the Effects, Local Adjustments or in the 
Layers panel, you can save those region selections when you create a new preset, by clicking on the Apply 
Masks item in the appropriate tab. Then, when you apply the preset to a new photo, anything (Effects filter 
or local adjustment) that had an AI-generated mask region — such 
as a sky — will be applied to those regions with the same name in 
the new photo. These preset types are called “adaptive,” meaning 
that they are applied to a photo based on ON1’s AI models.

Here are a few tips for working with adaptive presets:

• It’s best to create an adaptive preset that only uses AI-
generated masks. If you save a preset where any filters 
or local adjustments have masks that have been created 
by the standard masking tools (like the Masking Brush or Gradient Mask), those masks will be 
regenerated based on the precise location of the mask in the image that was used to create 
the preset.

• Any changes to the mask made via the Mask Control Options pane (see page 62) are saved 
with the preset.

• After you apply an adaptive preset to a photo, check the masks that the preset created. Quite 
often, you’ll find that you might need to use some of the mask refinement tools — or even the 
Masking Brush — to fine-tune your mask.

• Feel free to add your adaptive presets to any of the existing preset categories, or create your 
own category (see below for how to do that). For best practice, however, name or categorize 
adaptive presets such that you know which ones contain AI-generated selections.

USING THE AI STYLE ADVISOR

ON1 Effects’ AI Style Advisor is a special preset category of AI-generated presets. As you work in the Edit 
module, Effects pays attention to the type of editing you perform in all portions of the app, and, over time, 
it will add and refine adaptive presets to your My Style category. 

These presets will appear based upon the 
type of photo and the regions within them: for 
example, a portrait photo will have AI styles that 
use the Portrait AI settings you’ve used in the 
past. You can view the suggested presets either 
by running your mouse over the thumbnails in 
the preset browser, or by using the Quick View 
Browser.

Initially, the My Styles category will be blank. After you have edited approximately 200 photos, My Styles 
will populate with suggested styles, and as you continue to work within Effects, the My Styles category will 
expand and give you even better results.

Clicking Apply Masks in the Save Preset window 
will save your AI-generated regions. When you use 
that preset, those masks will be applied to similarly 
named regions.
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To get you started, the AI Style Advisor has a collection called ON1 Team, which is a collection of AI Styles 
from the photographers at ON1.

NOTE: The AI Style presets can’t be imported or exported from within Effects 
and won’t show up in the Extras Manager. If you like one of the AI Style 
presets, apply it, then save the current editing state as a standard preset. See 
“Creating Your Own Presets” on page 69 for more.

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Effects 2026 will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 Effects. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category from 
the pop-up.

• Choose Rename category if you wish to change the name of the category.

Right-click on a preset category to get the 
category pop-up menu.
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• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image in 
Effects.

Nesting presets

To help manage large groups of presets, Effects’ Extras Manager lets you nest preset categories. See 
“Extras” on page 16 for details on how to create and manage preset category subfolders.

Resetting edits
Any edits you have made with ON1 Effects 2026 can be completely reset while you’re working. The 
Settings menu offers five options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in Effects. (This option can 
also be accessed from the Reset All button at the bottom right of the Effects window.) 

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset All Retouching Tools: Resets any retouching applied to the photo.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original size.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

RESETTING INDIVIDUAL PANES AND SLIDERS

Any of the panes in the Effects and Local tabs can be returned to their default settings by clicking on the 
Reset icon, which is represented by ‘⟲’ at the top right side of the pane.

To reset the individual sliders in any of Effects’ panes to their default setting, double-click the setting’s label 
or the slider’s handle. 
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Soft Proofing
ON1 Effects’ soft proofing feature lets you 
see how a photo will look when printed, using 
the color profiles that get installed with your 
printer. Soft proofing helps you determine 
where there might be issues when you print, so 
that you can adjust your tone, color and effects 
to give you a print that is closer to your editing 
vision.

Normally, when you’re viewing an image in 
Effects, you are viewing it through the lens 
of your monitor’s display profile. The color 
gamut of your computer’s display is wider than 
that of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, 
or by clicking on the soft proofing icon to the 
left of the Preview button at the bottom of the 
main Effects window. You soft-proof various 
paper types by choosing an installed printer 
profile from the Profiles submenu. The image 
will change to approximate the color of the 
paper you’re profiling. You can also turn on an 
overlay that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in 
the View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu 
lists the currently available printer 
profiles. Choosing one will change the on-screen display to use that profile. You can also 
import profiles via this submenu.

These three screen shots show the results of soft proofing options. The top 
image is with soft proofing off (and is using the display color profile). The middle 
image is with soft proofing turned on, and using a printer profile for Epson’s 
Ultrasmooth Fine Art paper. The bottom image has the Gamut warning turned 
on; out of gamut colors are highlighted by the bright red overlay.
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• Intent: Effects offers two different rendering “intents” when soft proofing, which are used to 
convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
Effects to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft 
proof is tone, contrast and color accuracy between screen and print. 
When using a home printer, use test prints to hone in on the right mix 
of Effects adjustments. (See page 122 for information on printing 
photos from within Effects.)

Other Preview Options
In addition to soft proofing, ON1 Effects 2026 
offers a few other previewing options, which 
can be found Preview Option section at the 
bottom of the main window. With these options, 
you can compare the before and after views of a 
photo—in either split-screen or full-screen views—and see the current mask (with overlay options). 

CHANGING THE MAGNIFICATION VIEW 

Effects includes various options for zooming in or out of a photo while you’re working on it. In addition to 
the Zoom tool and the Navigation pane (see page 39 and page 27, respectively), you can change the 
zoom view by moving the magnification slider. You can either click on the control and slide it to the right to 
zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main window includes options for 
adjusting the preview magnification, for viewing the original photo, with all 
edits removed, turning compare (before/after) view on or off, and viewing the 
current mask (with a submenu for displaying mask overlays).
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BEFORE/AFTER PREVIEWS

As you work in Effects, it can be helpful to see how individual edits—via items in the different edit tabs—
affect your photo, as well as to see the cumulative changes made to the original image. The Compare mode 
displays a side-by-side view of your photo, with the original version on the left, the edited version on the 
right. There is a movable slider in the middle of the screen, which lets you view more or less of each view; 
click on the box at the center of the slider and drag it to the left (to view more of the edited image) or to the 
right (to view more of the original. While working in Compare view, you can use the magnification slider to 
zoom in or out of the image, which can be useful when you wish to see the effects of your edits on smaller 
sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

While you’re in the process of creating a mask, you have two options for displaying the contents of a 
current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Effects’ Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and 
contracting the different views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in Effects. You can 
also, via this option, show the mask as a red overlay only when you are brushing a mask. 

You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 Effects 2026, check the respective 
masking tools earlier in this chapter, as well as “Filter Masks” on page 85.

FOCUS AND CLIPPING VIEWS

Two additional—and powerful—previewing tools are available when you are editing photos: the Clipping and 
Focus Mask overlays. 

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have pure white or pure black in them. Areas with a bright 
blue overlay indicate pure black pixels, while areas with the bright red overlay indicate pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, Effects’ Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will continue to be displayed even as you zoom in 
on a photo.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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SHOWING OR HIDING EDITING ADJUSTMENTS

All of the individual filter panes and local adjustment panes inside Effects have a Show/Hide control in the 
upper left-hand corner of the panel. You can make your adjustments, and can click the control to turn the 
effect on or off. 

This option is not solely for previewing an 
effect; if the adjustment is turned off, it will not 
be present in the finished, edited image. This 
can be helpful if you’re trying different filters 
in Effects, for example, and you want to see if 
one looks better than another, or if you wish 
to see if it truly helps the photo or not. To turn 
the adjustment back on, click on the Show/Hide 
control so that the circle is filled.

If you wish to view your photo without those adjustments, you need to press the Reset icon, which is 
represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in the filter panels, see page 81.

To turn an effect or local adjustment off, click on the Show/Hide control in the 
upper left of an adjustment’s panel. If the control’s circle is empty, that effect is 
not implemented. Clicking the control will turn it back on.
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Working with Filters

With 37 different adjustment types—called filters—you can create stunning, pro-level photos with ease. 
Effects is extensively customizable in how filters are applied, and, when working with an image, you can:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Use blending options with all or some of the filters and set the opacity of each filter 
individually.

• Selectively apply a filter to specific portions of an image by creating complex masks using any 
of Effects’ masking tools, including the AI-based tools like the Super Select AI or Quick Mask 
AI tools. Or, you can use ON1’s innovative Mask AI technology to create masks directly from 
within the Add Filter window.

Filters are the building blocks of Effects’ editing power. Each filter acts like a movable, editable layer over 
the base image you are working on. You can use Effects’ masking tools to apply a filter to only part of an 
image and can change the blending mode (and opacity of the filter) to alter the way the filter interacts with 
those above and below it in the stack.

The Effects tab has 37 filter types, added either by the Add Filter button found at the top of the Effects 
tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and you can 
have more than one instance of a filter in the stack. (This can be helpful when you are creating complicated 
masks on an image and wish to apply the same filter differently in parts of the photo.)
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EFFECTS STARTING POINTS

New in Effects 2026 is Starting Points, which are a default starting preset that lets you jump right in with 
a set of filters that you use often, those that ON1 
recommends, or ones that mimic editing in apps like 
Adobe Lightroom Classic or Capture One. In most 
of the starting points, the filters start as off; you 
only need to turn on the ones you want to use. You 
can also create your own starting point presets and 
switch to them based on your needs.

The Starting Points pop-up menu is accessed on the 
right side of the Effects tab, underneath the master 
Opacity slider. Starting points are sticky, meaning 
that, once you select an item from the pop-up menu, 
that starting point will be invoked the next time you 
open a photo and switch to the Effects module. By default, the menu is set to Blank, which means that 
there are no preset filters in the Effects stack. The menu also includes three options from ON1, all of which 
start with a group of Effects filters turned off:

• ON1 Recommends: A group of eight filters that are often used by Effects users.

• Lightroom: Filters that mimic Lightroom’s Develop panel, minus the Basic pane.

• Capture One: Filters that mimic Capture One’s basic editing functions. 

The Last Used menu item will add the filters from the last time you used the Effects tab with a previous 
photo. Using this option will inherit the previous photo’s filters, and unlike the other built-in starting points, 
Effects will leave the filters on, with AI masks intact.

The Other submenu lists all of your presets. You can select one from the menu to be the new starting 
point, but if your preset also makes changes in the Local tab, those will be applied to subsequent photos. 

Starting points let you have a default set of filters every time you open 
the Effects tab with a new photo.

The ON1Recommends and the Lightroom starting points.
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NOTE: When you select an item from the Starting Points menu, all of your 
existing filters will be replaced by the new menu option.

To create your own starting point similar to the three standard ones (ON1, Lightroom, Capture One), and 
one that affects the Effects module, you should set up the Effects stack with your chosen presets, turn 
them off (if desired) and then save them as a preset, making sure that you are only saving adjustments in 
the Effects module.

See page 67 for complete information on creating and managing presets in Effects.

To create your own starting point similar to the ones provided by ON1, set the Effects stack with the filters you use 
most often, in the order you prefer. Turn them off by clicking the control circle in the filter’s title bar, then choose Save 
Settings as Preset, and make sure the preset is only applied to filters in the Effects module. If you name your preset 
category to start with a number, it will be at the top of the preset list, but it’s not necessary for this to work.
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FILTER OVERVIEW

Each filter pane has a different set of adjustment options 
and controls, but every filter has the same five sections:

A.	Filter on/off button (left); Show/Hide Mask 
(right); Filter Name.

B.	 Displays blending mode options (left); Resets 
filter (middle); Deletes filter from the stack 
(right). [Note: This section is only visible when your 
cursor hovers over the filter.]

C.	 Filter opacity setting.

D.	Styles sections for filter-based presets.

E.	 Control area with that filter’s specific settings 
(dependent upon the filter chosen).

The section titles for Opacity, Styles and the filter control 
area are collapsible and expandable. Click the gray label to 
hide that section from the pane.

THE FILTERS WINDOW

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of all 
37 filters in the center of the window. The filters are grouped into four categories: Essentials, Creative, 
Landscape, and Legacy. The Legacy filters are older filters that are not often used, or have been superseded 
by more recent filters.

When you click on the Add Filter button in the Effects tab, Photo RAW displays the Filters window, which consists of the Mask AI controls 
(left), the list of filters (center), and a description (right) of the filter your cursor is currently hovering over, with a sample preview (including 
a before and after split view).
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If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. ON1 Effects will then narrow down the search to those filters that 
match your search terms.

On the left side of the Filters window is the Mask AI pane, which lets you apply the filter with a region-
based mask. On the right side is the description field, which, when you mouse over a filter in the list, 
displays a before/after thumbnail of the effect, a short description, and a list of keywords that relate to that 
filter. If you’d like to have a smaller window, you can independently turn off the legacy filters section and 
the description section by clicking the ‘hamburger’ menu on the right side of the window.

Next to each filter is a small heart icon; clicking this makes it a 
‘favorite’ filter. To view only those filters, click the heart icon in the 
search field at the bottom of the Filters window.

Using Effects’ AI-based tools to mask regions 
automatically

Normally, when you add a filter, the filter is placed at the top of 
the Effects stack, and is applied to the entire image. If you’d like to 
selectively apply a filter automatically to specific areas in a photo, 
you have three options:

• You can use a tool like the Super Select AI tool to select a region and create a filter in Effects 
(see page 38 for information on using this tool).

• To add a filter from within the Effects tab, choose the Add Filter button, and select the region 
in the Mask AI section on the right side of the Filters window.

To reduce the size of the Filters window, you can 
independently turn off the Legacy filters and 
Description sections, by clicking the menu on the 
right side of the window..

You can use Effects’ Mask AI technology to create region-based masks in either the Masking tab of the 
Properties window (above left), or in Filter Browser when adding an effect (above right).
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• If you have an existing filter, you can also select a region from the Masking control tab of the 
Properties window. (Clicking on the Show/Hide Mask icon in the filter’s title bar will open the 
Properties window automatically.)

In addition to these options, you can also use an AI adaptive preset when you wish to create selections 
based on regions in a photo. (See page 67 for more on presets and their application.) 

APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel, Effects has an additional Filter 
panel on the left side of the screen. This panel lets you browse 
all of the filters inside Effects, and display previews of the 
available styles for that filter. 

To choose the Filters panel, click on the Filters tab. A list 
of the filters will appear, and clicking on a filter will display 
thumbnails of your image with that filter’s available styles. To 
choose one, click on the style, and Effects will add that filter 
to the Overall Settings pane. This will replace the currently 
selected filter in the stack; to add a new one on top of the 
stack, click the Add Filter button at the top of the Effects tab 
on the right panel, then choose a filter from the list. (You can 
also click and drag the title bar of any filter and move it up or 
down in the stack.)

If you’d like to see a larger representation of what your 
selected photo will look like with a filter’s styles, click on the 
Quick View Browser icon in the category’s title bar. That will 
display a window with all of the styles in that category (see 
page 68). Press the Escape key to close the window.

To change the size of the thumbnails in the filter styles panel, 
select the Browser Mode option from the View menu and 
choose One, Two or Three Column Thumbnail View. (If you 
choose Thumbnail from the Browser Mode submenu, the 
Filters and Presets panels will display as thumbnails.)

If you’d like help with what the different filter operations do, 
click on the Info button at the top right of the panel. With 
that button checked, when you hover over a filter, Effects 
will display a small pop-up window containing the same 
description (with before/after thumbnail) found in the Add 
Filter window. Click the Info button again to turn off this 
display.

Searching for filter styles

To search for styles inside the Filter Browser, type in the name you’re looking for in the search field at the 
bottom of the panel. The search results will appear in a new sub-folder called search results, which will be 
selected automatically.

The Filter Browser has a list of all the filters available in 
Effects (left). Clicking on a filter will display thumbnails of 
the filter’s styles using your photo (right). 
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Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or the Quick View Browser, you’ll 
see a heart icon. Clicking the icon will fill the heart in and add that style to your Favorites category. This 
category resides at the top of the filter list, and contains all filter styles you have selected as a favorite. To 
remove a favorite, open the Favorites category, and click again in the heart icon. To apply a filter style to a 
photo, simply click on the style in either the Filter Browser or in the Quick View Browser.

Filter pane details
By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking on the button in the top left corner of the filter pane will turn 
that effect on or off, which can be helpful if you want to see the effect in the context of other edits you 
have made. If you don’t like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset 
button, which is next to the Delete button, represented by ‘⟲,’ will reset that pane’s settings.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/
Show link is visible when you move your cursor over the title bar, but the entire 
title bar is clickable). If you don’t want to scroll up and down the filter stack 
with a lot of open panes, go to the Window menu and choose Solo Mode. This 
will leave the current pane open, and will hide all the other panes. Clicking on 
another pane will open that one and collapse the previous one.

STYLES

As noted in the section on the Filter Browser (page 83), 
all Effects filters have a set of built-in styles, and when 
you add a filter to the stack, you’ll see the Styles section 
in the top part of the pane. Styles are like preset 
adjustments for a pane: they provide a group of settings 
to help you get started in the pane, or to apply a specific 
effect.

You use a style by clicking on the style’s icon in the pane, and then can adjust 
the sliders as desired to get the right effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

Styles for the Split Tone filter.

Saved styles appear at the top of 
the More menu.
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FILTER MASKS

Every filter (and local adjustment) has a mask associated with it, which lets you apply that filter’s effect to 
specific areas of an image, using the Masking Brush and Gradient Mask tools. By default, the mask is white, 
which means that the effect is visible in every part of the image. Using the Masking Brush, for example, you 
can ‘paint out’ the effect in areas that you wish not to be affected by the filter. Alternatively, you can invert 
a filter’s mask and choose to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

Effects has two options for viewing the contents of a mask: either as a red overlay on top of your image 
(the default) or a view only of the mask itself, represented as grayscale. These options are available from 
the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch between 
the two modes. (Effects will remember the previous settings.)

For a full description of the masking options in the Properties window, see page 60. For more details 
about creating and manipulating masks in Effects—as well as some tips and tricks for working with masks—
see “Masking Basics” on page 58; information on the masking tools starts on page 40.

DELETING A FILTER

You can remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter, but would like a faded, muted color effect, simply reduce the 
opacity of that filter. The more you reduce the opacity, the less effect the Black & White will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 Effects 2026’s blend modes also let you apply a blend mode to specific colors or 
tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.
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To see the blending modes, click on the ‘hamburger’ icon, represented by three vertical lines, at the top 
right of the filter’s pane (this is hidden by default, but displays when 
you hover over the pane) and choose Blending from the pop-up 
menu. This will open the Blending tab in the Properties window. 
The blending option controls are:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in the 
list, including Normal, Lighten, Darken, Screen, Multiply, 
Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a 
specific color or tonal range. The options are; All (the 
default), Highlights, Midtones, Shadows, Reds, Greens, 
Blues, Magentas, Cyans, Yellows, Flesh Colors, Vivid 
Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and 
clicking on a color in your image.)

• The Protect sliders help protect highlight, and shadow areas and skin tones from the 
application of the blending mode.

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts 
the selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your 
adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Effects 
2026, it might be difficult to know which ones 
to use in any given situation, but they can easily 
be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 
Most often, when you know how you want to 
apply an effect —by darkening, for example—
you’ll need to perform a bit of experimentation 
with the different modes in that category to 
determine which mode works best.
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MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master blend mode options for the entire image stack, and includes a 
Master mask option. The Master Opacity slider, found at the 
top of the Effects tab, controls the strength of the composite 
filter stack against the original image.

The Master Blend Mode options can be accessed via the gear 
icon at the top of the Effects tab. It has the same controls as 
the blending options in the individual filter panes.

To create a Master mask, click on the mask icon next to the 
Save Preset icon in the Effects tab. This mask works on the 
entire effects stack, letting you selectively add or remove an 
entire effect.

Effects 2026 Filters
Effects has 37 filters available for you to use inside ON1 Effects 2026. Each filter has a set of styles in the 
top row, providing a range of popular or useful options for using that filter. You can also save your own 
preset styles by clicking the More pop-up at the end of the Styles row.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or hand 
colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the 
slider to the left decreases the saturation; moving it to 
the right increases it.

• Film Grain: Amount controls the strength and size 
dictates how large the grain appears.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, with additional toning features.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane lets you adjust 
brightness, contrast, highlights and shadows, whites and blacks.

Toner

The Toner section of the filter is designed to approximate many 
traditional and popular darkroom-based paper toners, from sepia 
tones to platinum, selenium, coffee and more. You can choose from 
more than 20 toning options via the Type pop-up menu, and adjust 
the combination of paper (which is represented by the Highlights 
section of the pane) and silver (represented by the Shadows). To 
tune your options, you can adjust the Hue or Amount of each 
setting, and use the Swap tones icon (next to the Highlights color 
well) to swap the highlights and shadows colors. The Preserve 
Whites and Blacks button keeps the pure whites and pure blacks 
neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, 
like the Toner section, is designed to add a classic film grain look 
to your photos. To add film grain, choose from the drop-down list 
of popular black and white films. The Amount slider controls the 
strength of the effect, while the Size slider adjusts the scale of the 
grain.
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BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or 
by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: This adds the appearance of movement. The 
Amount slider controls the strength of the blur, and 
Distance controls the blur relative to the subject and 
camera. Angle sets the angle of the blur, and the Smoothing slider softens the lines created 
by the motion.

• Radial: These blurs are circular, zooming out from a central point. Amount controls the 
strength of the blur. Quality controls how noisy the blur is, with 1 being grainy and 100 
smooth. Smoothing softens the lines created by the motion. The Radial blur type includes a 
center spot selector at the bottom of the pane. Click on the icon, then click on the part of the 
image you want to make the center of the blur.

• Surface: These blurs tend to maintain edges but add blur to the details. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.

• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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BORDERS

ON1 Effects 2026 has a large collection of pre-made borders and 
edges that you can add to your photos. These borders range from 
classic film borders to viewfinders to artistic effects to emulsion 
transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager (see page 16). 
Border files need to be a standard PNG file type with a large 
central transparent area

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are 8 built-in categories, sorted by type. Any user-
imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending 
mode and opacity, and, if the border has color, you can adjust its 
hue, saturation and brightness. Alternatively, if the border is black 
or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you 
scale the border up or down in size, to help you get the look you’re 
after, and the Fit Image slider adjusts the size of the image under 
the border.

You can rotate or flip the currently selected border by clicking the buttons at the bottom of the screen.

NOTE: See page 16 for information on how to use the Extras Manager to 
import borders, textures and other extras, along with additional information for 
preparing files for the Borders and Textures filters.
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CHANNEL MIXER

The Channel Mixer filter adjusts the intensity and color of the 
individual red, green and blue channels in a photo. You can use it 
for black and white conversions, channel swapping for infrared 
shots, or to shift entire color ranges.

Click on the channel icons to select a specific channel, and use 
the Red, Green and Blue sliders to increase or decrease the pixel 
values for that channel. 

The Constant slider affects the luminosity of the currently selected 
channel. 

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings include:

• Range: This slider lets you narrow or widen the range of 
the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color 
range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to adjust the hue, saturation or brightness dynamically. 
To do this, click on the tool and choose which parameter you would like to adjust. Then click in your image 
on a color you would like to adjust and drag the cursor to the left or right to decrease or increase the effect.
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COLOR BALANCE

This filter lets you adjust the colors in a photo’s highlights, 
midtones and shadows tones. This can be useful when you wish 
to color grade a photo, remove color casts from shadows or 
highlights, or to create duotone- or tritone-style images.

The tonal ranges are represented by color wheels. To adjust colors, 
click on the circle at the center of the specific tonal range you 
wish to adjust (Highlights, Midtones, Shadows) and drag the circle 
inside the wheel. The angle from the center represents the hue of 
the adjusted color, while the distance from the center of the wheel 
represents saturation. 

The slider underneath each wheel corresponds to the brightness of 
the tonal region.

On the outside of each wheel is a readout of the hue, saturation 
and brightness; it updates as you move the circle inside the wheel.

COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect 
and remove a color cast. It makes adjustments to the 
Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. 
Click the icon to activate, then click on an area in the 
image that should be gray. The sliders will automatically 
adjust according to the sample you have selected.

• White Balance: This pop-up lets you change the white 
balance according to common color temperatures (As 
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Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, Custom). The default is As 
Shot, the color temperature that the camera recorded when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors 
alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.
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CURVES

The Curves pane is a powerful—and advanced—tool for adjusting 
contrast, tone and color in your image. 

The main section of the pane displays the histogram of the current 
image in the background; the gradient behind the histogram is 
designed to give you a sense of how the tones will change as you 
adjust the curve. 

The center line is a linear representation of the image’s tonality, 
ranging from 0 to 255; the point at the bottom left represents the 
darkest tones in a photo (minimum of 0), while the point at the 
upper right represents the lightest tones in the photo (maximum 
of 255). By clicking along the line at the center of the pane and 
dragging it up or down you adjust specific tones by making them 
lighter (up) or darker (down). 

By default, the pane shows the composite RGB channel, but you can view and adjust each channel 
separately by clicking on the appropriate tab (Red, Green, or Blue). When looking at the individual channels, 
the background gradient will indicate what color shifts will occur when you adjust the curve. For example, 
raising the points on the curve in the Red channel will move the data more towards red, while lowering the 
points on the curve will move the data more towards green. 

Moving the line adjusts the tonality by adding control points along the line (turning the line into a ‘curve,’ 
hence the name):

• Inside the pane, clicking anywhere along the center line will add a point, and you can drag 
that point up or down to change the tones.

• You can also click on the Dropper tool to the left of the channel tabs, then click and drag 
inside the photo at a location where you would like to adjust the tonality. This adds a point at 
the precise tonal location on which you clicked.

You can add multiple control points to the curve, and readjust 
them at any time by clicking on the point in the pane. You can 
“slide” a point along the curve, or you can click and drag up or 
down. If you are familiar with numeric-based color values, you also 
click on a point and use the In or Out boxes to adjust the input or 
output values of the tones at that point. 

To remove a point, right-click on it and choose Remove Control 
Point. Note that there is always at least one control point selected.

Working in the individual RGB channels alters the tonality of each 
specific channel, but the adjustments are similar. To reset any 
curve adjustments made in a channel (or in all channels), right-click 
in the grid, and choose Reset Channel (or Reset All) from the menu.

The Style pop-up for the Curves filter has preset options, including settings for color negatives, matte-style 
looks, and more. If, for example, you regularly apply a classic S-curve to your photos, you could set the 

Right-clicking on a control point gives you the 
option of removing that point. You can also reset 
curve adjustments made to one or all of the 
channels.
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curve the way you like it, and then choose Save New Style from the pop-up. If you apply a style and make 
adjustments to it that you would like to save, select Update Style with Current Settings from the menu.

NOTE: The Curves section of the Tone Enhancer filter (page 107) operates in 
the same way as the Curves filter, with the sole exception being that there are 
no curve-specific style options available.

DEPTH LIGHTING

The Depth Lighting filter lets you easily darken or lighten the 
foreground and background in a photo, helping improve the 
definition between subject and background easily. 

When you add the filter, Effects builds a depth mask of the 
photo. This lets you adjust the brightness of the foreground and 
background separately, as well as the temperature. 

The Foreground and Background sliders work independently of 
each other. Moving the Foreground slider to the right will increase 
make it brighter, while moving the Background to the left will make 
that area darker.

The Depth slider controls what is foreground and what is 
background in the scene; holding down the Alt/Option (Windows/
Mac) will display the depth mask ask you adjust the setting.

Transition essentially feathers the depth mask, which can improve 
the effect in some circumstances.

The temperature sliders can be used similarly to the brightness 
controls, but the settings are from cool (left) to warm (right).

TIP: Hold down Alt/Option (Windows/Mac) when adjusting the Depth and 
Transition sliders to show the mask overlay.



ON1 Effects 2026 User Guide	 Part 2: Working in Effects	 96

DOUBLE EXPOSURE

The Double Exposure filter lets you make creative double 
exposures using your photo as a base image. It is similar in use to 
the Textures filter, in that you apply a second file that is overlaid on 
your photo, and then you use AI masks and blend modes to get the 
effect.

To get started, you can either import a photo of your own or select 
one from the Category and Texture menus. The Masking option 
defaults to no mask, but you can change it so the overlay masks 
the subject or the background. You can also set the overlay to be 
masked with either a standard depth mask, or an inverted depth 
mask. 

The Mode menu includes four blending mode options — Normal, 
Subtle, Darker, Lighter, Replace — to help you tune the final result, 
and Opacity determines how strongly the overlaid photo is applied. 

The Tone and Color section are used to adjust the brightness, 
saturation and hue of the overlaid photo, while the Position section 
lets you move the overlay with the Adjust Double Exposure target, 
scale the photo, and rotate or flip it.

The Background Adjustments section uses depth masks to brighten 
or darken the background area of the double exposure.

NOTE: See page 16 for information on how to use the 
Extras Manager to import images for use with the Double 
Exposure filter.

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.
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EDIT COLOR

The Edit Color is designed to precisely target a specific range of 
colors and then subtly tweak those colors. It gives you the most 
precise control over color of any filter within Effects.

Use the eyedropper to select a color in your photo. The Color 
Editor will display a slice that includes the color range based on the 
selected color (which is shown by the ‘a’ symbol inside the slice).

After you’ve selected a target color, click the Eyeglasses icon; 
Effects will display the photo in grayscale; only the colors within 
the currently selected range will be visible. Using this view, the 
selected color range can be further adjusted, via two primary 
options:

• To expand or contract the selected range, click and drag 
the handles at the outer edge of the circle. This increases 
or decreases the hue angle for the selection.

• To restrict colors within the range based on their 
saturation, click and drag from either the center position 
(less saturation) or the outer position (most saturation).

As you make adjustments to the color range, the colors in the grayscale view expand or contract, 
depending upon intent. The Feather slider determines how quickly the adjusted colors will change, lower 
numbers mean more abrupt changes, while larger numbers give a more gradual change in the colors at the 
edges of the range.

Once the color range has been selected, use the Hue, Saturation and Lightness sliders to change the 
selected colors. 

The Edit Color Filter is a precision tool designed for slight color shifts within a color range. For more 
extreme shifts, or to change one color to another, the Replace Color filter (see page 28) is generally a 
better option.  

There are two tools that you can use to further manipulate the color range. The first one, (left, 
above) expands or contracts the color range by clicking and dragging the handles at the upper 
and lower boundaries of the range. The second tool (middle and right) manipulates the color 
range based on saturation. 
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FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

ON1 Effects 2026 has a wide range of grain types from classic 
black-and-white negative films from Kodak, Ilford and Fujifilm. To 
add grain, choose from the Film drop-down menu.

The Amount slider controls the strength of the effect, while the 
Size slider adjusts the scale of the grain.

GLOW

This pane adds a soft-focus glow to the image, which can be 
accentuated by using different blending modes. The Styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall strength of the glow.

• Halo: Sets the radius of the glow effect; higher numbers 
create more ‘fuzziness’ to your image’s edges.

• Mode: Lets you set the blending mode for the glow 
effect.

GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Like the Dynamic Contrast 
filter, HDR Look will often benefit from masking or via blend 
modes. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Masking Bug to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.

• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.

• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has  a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. 

Effects can import common LUT file formats, including .3DL and 
.CUBE file types.

• Category: This pop-up menu lets you choose from one 
of the pre-installed LUT categories, or any categories you 
have imported into Effects.

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See page 16 for information on how to use the Extras Manager to 
import LUTs into Effects.

MATCH COLOR

This filter applies the color and tone from one image to another. 
This image can be from a layer in the current photo, or from a 
different file. 

The Reference pop-up contains a list of the current layers and a 
short list of recent photos worked on inside Effects. You can also 
load another file from the pop-up, which will be saved for future 
reference.

The Color, Luminosity, Contrast and Saturation sliders can be used 
to tweak the tonality of the filter on the current photo.
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MOTION

The Motion filter lets you add intentional camera movement (ICM) 
techniques to your static photos. The filter’s Motion options let 
you apply an effect to a photo, and can isolate either the subject 
or the background from the effect. The three motion types are 
different effects to simulate ICM shots:

• Pan: Simulates the movement of a camera with the 
subject as the photo is being taken.

• Zoom: Simulates the zooming in or out of a lens as the 
photo is being taken.

• Twist: Simulates the twisting of a camera as the photo is 
being taken.

Within each motion type, the Amount and Angle control the 
strength and the angle or direction of the motion. Smoothing adds 
a bit of blur to the overall photo, which can be helpful if the effect 
feels a bit fake. Zoom and Twist also have a Set Center option, to 
place the center of the effect in any region of the photo.

Use the Protect option to keep either the subject or the background from the effect. The Feather slider 
feathers the transition between subject and background.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied 
just to the color or chroma of the image.

• Detail: Controls how much edge detail is protected. Hold 
down the Alt/Option key to see the edge mask while 
adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on 
color or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range (or ‘fuzziness’) of the 
color range to apply the noise reduction to.
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PHOTO FILTER

This filter recreates traditional color lens filters used for warming, 
cooling, gradients and more. You choose the filter type from the 
pop-up menu at the top of the pane, then adjust the settings to 
your liking. Each type offers different options for selecting a filter 
color (or colors, in the case of the Bi-Color type), adding saturation 
or polarization, and more.

There are four Filter Types: Solid, Graduated, Bi-Color, and Center. 
The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong 
you want the effect, as well as a Saturation slider for boosting 
or reducing overall color. The Polarizer slider adds a polarization 
effect, which can sometimes help clear haze or enhance the blues 
and greens in an image.

The Bi-Color and Graduated filter types let you choose filter color (or colors), feather for the filter 
transition, and a direction for the effect.

The Center type works much like the Graduated option, with the difference being that the filter radiates 
from the center of your image, and you can choose the center to be either clear or colored.

REPLACE COLOR

This filter lets you select a color range and replace that range with 
one of a completely different color. When used with filter masks, 
you can achieve targeted color changes in a photo with ease, while 
retaining the other colors in the image.

The top section of the filter is used to select a target color, and the 
bottom section is where you pick a replacement color. 

First, use the eyedropper tool to select a color from your photo, or 
click on the color swatch to pick one from the color wheel. Adjust 
the Range slider to add or remove colors similar to your target. The 
Amount slider is similar to an opacity setting: anything less than 
100 (the default) will blend the new color with the original color. 
You’ll see the results in real-time, so you can get a good idea of the 
selection.

In the Color Change section, click on the swatch to set a new color, or use the Hue, Saturation and 
Brightness sliders to get the color you’re after. If you have areas where you don’t want the source colors 
changed, use the masking tools to paint the effect out.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Effects 2026 offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which one 
you use depends upon the image or your personal preferences. The 
styles section has a range of sharpening styles.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the 
sharpening effect. Smaller amounts keep fine detail, 
while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the 
sharpening effect based on contrast in your photo. 
Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the 
entire face. It is great for correcting overly yellow 
highlights, shadows that may be green or reducing 
redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.
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SPLIT FIELD

The Split Field filter mimics the classic glass filter of the same 
name, also known as a split diopter. It lets you magnify half of the 
scene to balance out size differences caused by wide angle lenses. 
It lets you magnify and move the background, bringing it closer, as 
if you used a telephoto lens, while maintaining the wide angle look 
in the foreground. 

The Scale option in the Appearance section adjusts the size of the 
magnified section, while Blur blurs the background.

The Position section lets you adjust where the line between the 
split occurs (Distance), the angle of the background, and the 
transition from the larger background to the normal foreground. 
The Adjust Magnified Position target lets you move the 
background into place.

The filter also has an on-screen control — similar in appearance 
to the Gradient Mask tool — that can adjust the position, the 
transition, and the angle of the effect.

SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant. You can swap the Highlight 
and Shadow Colors by clicking the button to the right of the 
Highlight color.

The Mode pop-up sets the blending mode for the split tone. The 
options you can choose from are Normal (no blending), Color, 
Lighten, Darken, Multiply or Screen.
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SUN FLARE

This filter adds realistic-looking sun flares, sun stars and bokeh 
overlays to a photo. You can resize, move and adjust the tone 
and color of the effect, and can also add toning similar to the 
standalone Sunshine filter. The Type pop-up lets you choose 
between the three options (bokeh, flare or star), and the Texture 
menu displays a range of options for the chosen type.

The Tone & Color section of the filter lets you adjust the 
brightness, saturation and hue of the current texture.

To move the position of the texture, click the icon next to the 
Transform label, then click and drag on the overlay to the desired 
spot. You can use the Scale slider to enlarge the overlay, and you 
can rotate or flip it by clicking on the icons to the left of the Fit to 
Canvas button.

The bottom of the Sun Flare pane includes a version of the 
Sunshine filter, letting you adjust the warmth and saturation of the 
overall effect. The Fade slider gives a matte look to the final effect.

SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.
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TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Effects 2026 comes with an extensive set of textures that 
you can add to your photos, ranging from fabric, metal, stone, text 
and more. You can also import your own textures directly into the 
Borders filter pane, or via the Extras Manager (see page 16). 
Texture files can be almost any image format (JPEG, TIFF, Raw or 
Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top 
of the pane, used to help you narrow your texture search. There 
are nine texture categories, sorted by type, and any user-imported 
textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, 
saturation and brightness. Alternatively, if the texture is black or 
white, you can colorize it by clicking on the Colorize button in the 
bottom half of the pane.

The Transform section at the bottom of the pane lets you scale the 
texture up or down in size. You can also rotate or flip the texture 
by clicking the buttons at the bottom of the screen, which can be helpful to achieve the look you desire.

NOTE: See page 16 for information on how to use the Extras Manager 
to import textures (and other extras), along with additional information for 
preparing files for Borders and Textures.
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TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It offers similar 
controls to the Tone section of the Tone & Color pane, and also 
includes a curves dialog.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The curves dialog is a powerful, advanced tool 
for adjusting contrast and color. For specifics on how to 
work with this feature, see “Curves” on page 94.
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VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from 
square to round.

• Type: This menu lets you select a Normal, Subtle, or Soft 
vignette effect. The Priority option will let you preserve 
highlights when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.

VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century. 

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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WEATHER

This filter adds weather-inspired overlays to a photo. The 
Precipitation section at the top lets you add rain or snow overlays, 
by choosing a type from the Texture pop-up menu. You can adjust 
the opacity of the effect, and can scale, flip or rotate the overlay 
via the Transform section of the panel.

You can also add fog effects to a photo. To turn this effect on, 
raise the Amount slider in the Fog section at the bottom of the 
pane. The Position pop-up menu includes a number of gradients 
for applying the effect (choose All to apply the effect to the entire 
image). Choose the one that is the best starting place for your 
photo.

The Distance and Transition sliders act upon the gradient, letting 
you choose the intensity and length of the Position gradient, while 
the Rotation slider lets you adjust the angle.
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PART 3: USING LOCAL ADJUSTMENTS
The Local Adjustment tab uses Effects’ extensive masking 
capabilities to create localized editing adjustments to portions 
of an photo. You can create these adjustments with any of the 
single-click masking options (Subject, Background, Sky, Depth 
and Luminance); with the Super Select AI tool or any of the 
dedicated masking tools; or Mask AI region selection feature.  

You can create as many local adjustments as you need with an 
image by clicking in the Add Adjustment section at the top of 
the Local Adjustments panel. 

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated 
vignette to an image. Local adjustments are in essence a 
mask that is applied to a portion of your image, and you can 
manipulate those masks in powerful ways with both the 
blending modes and the luminosity options in the Local tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), color 
(white balance, saturation and vibrance) and detail (structure 
and noise). Each local adjustment layer can have completely 
different settings and work on different parts of your image. 
You can also use local adjustments to paint with color over 
part of a photo, to perform specialized tasks such as skin 
retouching or to replace the color of an object. 

Local adjustments are independent from the Effects tab; you 
can create a local adjustment while working in Effects, and 
when you click on the Effects tab, your local adjustments 
remain intact.

CREATING LOCAL ADJUSTMENTS

To create a local adjustment, click on the Local tab, and 
choose any of the icons in the Add Adjustment section of 
the Local tab. While the icons in this section look different 
than those in the Masking Properties window, all of the 
mask-creation options in that window are present in the Add 
Adjustment section or via the More menu. 

At the top of each adjustment pane is an Opacity slider, which 
sets the opacity of the adjustment. The Styles section has a 
number of canned styles for you to start with, including ones 
for lightening or darkening (dodging and burning), adding vibrance, fixing teeth or red eye, and many more. 
(You can also save your own styles via the More menu.)
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The main section of the Local tab has a number of settings to adjust the color and tonality of your 
selection: Exposure, Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation and 
Vibrance. In addition to those settings, the local adjustment pane includes a Noise slider, designed to help 
reduce noise on a targeted level (most often seen in the shadows), as well as Structure and Haze sliders.

Effects also provides you with a number of blending options for each adjustment. Blending modes 
determine how the selected adjustment blend with the items below it.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

Click on Properties’ Blending tab to change the blending options for the current adjustment:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: Applies the blending mode to a specific 
color or tonal range. The options are; All (the 
default), Highlights, Midtones, Shadows, Reds, 
Greens, Blues, Magentas, Cyans, Yellows, Flesh 
Colors, Vivid Colors and Neutrals. (You can also 
manually choose a color range by selecting the 
Dropper Tool and clicking on a color in your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, 
or saturation range specified. The Range slider 
expands or contracts the selected option, and the 
Highlights, Shadows, and Skin sliders protect those 
settings from your adjustments.

• The Protect sliders help protect highlight, and shadow areas and skin tones from the 
application of the blending mode.

For detailed information on how the various blending modes work, see page 85.

CREATING LOCAL ADJUSTMENTS WITH THE SUPER SELECT AI TOOL

Effects’ Super Select AI tool can also be used—from either the Effects or the Local tab—to select a region in 
a photo, apply a preset local adjustment style, and open it in the Local tab. For detailed information on the 
Super Select AI tool and how it works, see page 38.
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OTHER MASKING OPTIONS

Every local adjustment has its own mask, and it uses the same masking options and controls found in 
throughout Effects. To access the mask, click on the mask icon in the title bar of the local adjustment layer. 
There you can copy and paste masks, create luminosity masks, and create masks based on color ranges. For 
specific details on how to work with these masking options, see “Masking Basics” on page 58.

PAINTING WITH COLOR

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by 
blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a midtone section of skin, 
and, using a low opacity setting, paint over parts of the skin with the brush. This option is also useful when 
you are using custom brushes to add overlays to a photo. See page 113 for more on this.
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USING CUSTOM BRUSHES TO ADD OVERLAYS TO PHOTOS

One specialized use for local adjustment layers and the Paint With Color’s Solid Paint option is to add 
overlays with custom brush shapes. You can paint in stamps, watermarks, and other shapes to create 
specialized creations or enhanced photos. For example, you could use a custom cloud brush to add interest 
to a lackluster sky, or you could create your own watermark and apply it precisely. Effects comes with a 
collection of custom brushes of all kinds, and you can import any black-and-white TIF file or Photoshop-
compatible .abr brush file for use in the app, via the Extras Manager (see page 16).

Creating basic overlays with a custom brush is easy:

1.	 Create a new local adjustments layer by clicking on the Local tab.

2.	 If the Adjustment Brush isn’t selected in the Tool Options bar, select it, and choose a new 
brush from the Shape menu in the options bar.

3.	 Set the brush size and angle. In general, you’ll want to keep the Opacity and Flow high, and 
the Feather low (or 0), but that will depend upon the brush and the application.

4.	 From the Masking Brush Options menu (see page 41), turn the Manual Spacing option 
on. Depending upon the brush type and the application, you’ll have to play with the Amount 
slider, but the general rule of thumb is, for stamped brushes, where you wish the shape to 
be applied singly, set the spacing low. If you wish to apply the brush multiple times with a 
stroke—and have clear definition between the brush shapes—set the spacing higher (see the 
spacing chart below for an illustration of the different settings).

5.	 Turn the Paint With Color option on and set to Solid Paint. Choose a color for brush, and 
paint as desired on the image.

Using custom brushes, available via the Brush Shape pop-up in the Adjustment Brush’s Tool Options bar, you can easily add realistic shapes—such as the 
clouds shown here—as overlays to your photos.
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TIPS FOR USING CUSTOM BRUSHES

• The best way to begin working with brush overlays is to practice. Use some of the default 
brushes, and play with them by adding them to a photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in Effects is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

• The Paint With Color option applies to all brush strokes made on that adjustment layer. You 
can easily change the color via the color patch in the panel. If you want to apply the same 
stamp with different colors, create a new adjustment layer for each color.

This chart shows the effect of the Manual Spacing on a brush stroke for a star custom brush. With a spacing of 100, as you stroke, 
the stroke will be applied with plenty of space between the brush shape. With a spacing of 0, the shape will meld together as you 
apply the stroke. Depending upon the brush type, this might be acceptable for your purposes.
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PART 4: WORKING WITH LAYERS

The Layers functionality inside ON1 Effects lets you create quick composites, blend multiple images 
together, paint in new skies or backgrounds, align layers based on their content, and much more. And, 
because Layers is tightly integrated within Effects, all of your work remains re-editable at all times: you can 
go back and add, change or update any setting made in the Effects and Local tabs, on any layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own. But more than that, each layer has its own non-destructive settings—just like any photo 
in Effects, all the way back to the original raw data. 

When you add a layer to a photo, Effects 
automatically creates a new document with an 
.onphoto extension, leaving your original photo 
intact. This document type contains all the 
layer information and non-destructive editing 
operations made inside Effects. 

Layers can be as simple as copies of the current 
photo, to apply more complex adjustments to 
portions of an image than you could with local adjustments. You can also add other documents as a layer 

When adding a layer to a file, Effects creates a new file with an .onphoto 
extension in the original file’s directory. Despite the dialog’s reference, this file 
is also re-editable in ON1 Effects
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inside the current document, for replacing skies or other backgrounds, for adding textures, or for when you 
wish to create complex collages. Effects supports up to 14 layers in a document.

Once you have added a layer, all of Effects’ options are available for that layer. When you click on a layer, 
you can add any filter or local adjustment, create masks, and more. You can use the Transform tool to move, 
rotate, and scale the contents of a layer independently from the complete document. (Because the Crop 
tool works at the document level, you can’t crop a group of individual layers together.)

CONFIGURING THE LAYERS PANE’S LOCATION

Like the Properties window, the Layers pane can be configured so that it resides in either the right or left 
panel on the screen, or works as a floating window. You can also hide the pane completely in any of the 
configurations. 

You set up the Layers pane location and visibility via the Window > Layers menu. There you can nest the 
pane on either the right or the left side; unchecking both items will turn the pane into a floating window. 
Show will display the pane in all configurations, while Auto Collapse will reduce the pane to the title bar 
whenever you move the cursor away from it, and show it when you mouse over the pane (or window). 

The Layers pane can be configured so that it resides in either the left or the right side panels of the Edit module. If you want a floating window, 
uncheck the Left Side and Right Side options in the Window menu.
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Adding a New Layer
The easiest way to add a new layer to an existing image is to choose Add Layer from File item in the Layer 
menu. This will open the Add Layer window, which will two tabs in it: Extras and Folders. The Extras tab 
will display two folders, ON1 Extras and My Extras. The ON1 folder will include all of the Extras installed 
with your copy of Effects, including backgrounds, textures, borders, skies, and more. The My Extras folder 
will include any similar files you have added to Effects via the Extras Manager (as described on page 16).

If you wish to open a different file, click on the Browse button at the top of the Add Layer window, which 
will open your computer’s file selection dialog box, where you can navigate to the specific file. Any file 
compatible with ON1 Effects 2020 can be opened and added as a layer.

NOTE: You can also copy and paste pixel-based image data from other apps 
into Effects. Choosing Paste will create a new layer with the copied pixels. 

CREATING A COLOR FILL LAYER

In addition to opening other document types, Effects can create a layer filled with a solid color, which can 
be quite useful when working with sophisticated composites or blend modes. Choosing Add Color Fill Layer 

When you choose Add Layer from File, a window appears with Extras and Folders tabs. The Extras tab contains backgrounds, textures and borders 
supplied by ON1 with Effects, as well as any extras you might have added via the Extras Manager. Clicking on the Folders tab (or the Browse button at 
the top right of the window) will let you browse your computer for photos and other supported files.
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from the Layer menu (or clicking on the Color Fill icon in the Layers tool bar) will open the system color 
picker, where you can choose a color for your new layer. You can change the color of any color fill layer by 
selecting it in the Layers pane and choosing Edit Color Fill from the Layers menu.

OPENING A LAYERED PHOTOSHOP FILE

ON1 Effects 2026 can open most layered Photoshop files. What happens depends upon the composition 
and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, Effects will open the 
document with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles—Effects will 
flatten the visible layers and will open the file as a composite image, with a single layer.

NOTE: If the file you add is larger or smaller than the pixel dimensions of 
the document, use the Transform tool to resize it as desired. If you wish to 
preserve the original aspect ratio of the placed file, use the Shift key to resize it 
proportionally. 

Working with the Layers Pane 
The Layers pane has three sections:

A.	Layer Blending and Opacity: Lets you 
set the blending mode and the opacity 
of the currently selected layer.

B.	 Layers: All of the layers in the current 
document, with a thumbnail of the layer 
contents and the layer mask (if there is 
one); the currently selected layer has a 
slightly different background tone than 
the other layers. Layers can be renamed 
by double-clicking on the title.

C.	 Layer Tools: The toolbar at the bottom 
of the Layers pane includes buttons for 
performing basic layer operations (described in more detail below).  

LAYER PANE OPERATIONS

There are a few basic operations you can perform directly inside the Layers pane:

• A layer’s visibility can be turned on or off by clicking the button to the left of the layer 
thumbnail. When turned off, the layer has no effect on the composite image. 

The Layers pane in Effects. This photo has three active layers.
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• The Opacity slider controls how opaque or how strong the selected layer is. The default is 
100%. At lower settings, the layer will blend with the layer(s) under it. Altering the blending 
mode and opacity of a layer can create a wide range of color and tone effects. 

• You may change the order of layers by dragging and dropping layers into the order you prefer. 

• You can rename a layer by double-clicking on it. The name turns into an editable field. Type in 
your preferred name and press Enter. 

LAYER PANE TOOLBAR

All of the layer commands in Effects can be 
accessed via the Layers menu and a pop-up menu 
that you get when you right-click on any layer. The 
toolbar at the bottom of the Layers pane, however, 
contains the basic commands you need when working with layers. From left, the icons represent:

• New Layer: Adds a new layer, opening the Add Layer from File window.

• Duplicate Layer: Makes a duplicate layer, including any Effects and Local Adjustments 
settings made in the original image.

• New Color Fill Layer: Creates a new color fill layer.

• Delete Layer: Deletes the currently selected layer.

• Merge Layer: Merges the currently selected layer with the one directly beneath it in the 
Layers stack.

Other layer commands, available via the Layer menu or pop-up, include:

• Edit Color Fill: Lets you re-edit the current color fill layer’s color.

• Reset Layer Properties: Deletes any layer masks or transform 
operations you have made to the current layer. To reset Effects or 
local adjustments made to a layer, click the Reset Layer button at 
the bottom right of the main window.

• Merge Visible: Unlike the Merge Layer command, this will merge 
all of the visible layers—ones with the layer visibility status set to 
on—in a file into a single composite layer, with all of the merged 
layers’ effect applied.

• New Stamped Layer: When you have the top layer in the stack 
selected, this option will create a new composite layer at the top 
of the stack, with all of the layers’ effect applied.

• Align Visible Layers: This will align the visible layers, based on the 
content of the layers. See page 121 for more information about this feature. 

Changing Blending Modes 

Blending modes determine how the selected layer blend with the layer(s) below it. The default blending 
mode is Normal. This maintains the full opacity of the upper layer. Layers also supports many other 
blending modes which can be used to alter the brightness, contrast and color of the image. See “Blending 
Modes” on page 85 for more detailed information on this topic. 

Right-clicking on a layer brings up a 
list of available Layers operations.
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Layer Masks 

If you use any of the masking tools, a layer mask will be created automatically. Clicking on the layer’s mask 
icon will display the standard Effects mask options, and you can use all of Effects’ masking tools to create 
or modify layer masks. You can also copy and paste layer masks—including masks from Effects filters—via 
the Mask options section or via the Mask menu. See “Filter Masks” on page 85 and “Masking Tools,” 
starting on “Masking Tools” on page 40 for more on using Effects’ masking tools.

VIEWING EFFECTS SETTINGS FOR A LAYER

Each layer in the Layers pane has a hidden list that shows 
all of the operations in the Effects and Local tabs that have 
been applied to the current image. To view the list, click 
once on the layer’s title. This will drop down the settings 
view for that layer. 

The list will show every tab that has had adjustments made 
to it, and you can drill down further into the tabs to see 
which adjustments were made to an image. 

Double-clicking on any of the available items inside the 
Settings Applied area will jump to that setting, where you 
can adjust it easily.

Using the Transform Tool with Layers
Use the Transform tool (see page 36) at the top of the Toolbar to manipulate layers. A layer may be 
repositioned, sized or rotated using the tool. When selected, transform handles will appear on the edges of 
the selected layer. You use these transform handles to manipulate the image. You can only transform one 
layer at a time. 

REPOSITIONING A LAYER 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

RESIZING A LAYER 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

Clicking on a layer’s title will display the editing settings that 
have been applied to that layer. Double-clicking on one of 
the items will open that specific pane in the Effects or Local 
tabs. Click on the layer name once more to close the settings.



ON1 Effects 2026 User Guide	 Part 4: Working with Layers	 121

ROTATING A LAYER 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 
Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer in 90 degree increments, use the rotate left and rotate right buttons in the Tool Options bar. 

FLIPPING A LAYER 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 
When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

ALIGNING LAYERS

Effects can also align multiple layers based on content. This can be a great aid when you’ve hand-held a 
group of shots, and want to blend portions of one image onto another, to use a better sky, for example. 

To align layers, open the images in the Layers pane, and choose Align Visible Layers from the Layer menu or 
pop-up menu. Effects will then analyze the contents of the layers, and align them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content.
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PART 5: PRINTING

ON1 Effects 2026 has a flexible print engine that can print photos at any size. You can print photos 
individually; or multiple versions of a photo, package style, on a single piece of paper. You can even print 
when using Effects as a plugin from any of its supported image editors. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo being printed.

B.	 View Selector: The first three icons are not applicable inside Effects; the icon on the far right 
turns soft proofing on and off, when an ICC profile is selected in the Profile menu.

C.	 Page view: Displays the number of pages being printed. (Not applicable in Effects 2026.)

D.	Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

E.	 Print Area pane: Contains options for fitting and selecting the print image size.

F.	 Watermark pane: For adding a watermark to printed photos.

G.	Sharpening: Options for sharpening during the print process.

H.	Print/Cancel: Print the current photo or cancel the operation.
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NOTE: The print engine in Effects 2026 is based upon the engine inside Photo 
RAW, which has the capability to print multiple photos at a time. Because 
Effects can only work with a single photo at a time, some of the print options, 
like contact sheets and some view settings, are not applicable in Effects.

Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to 
a connected printer, and File, which saves the photo as a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing 
resolution, make sure that you are printing at the printer’s 
optimal resolution. Most photo printers, for example, work best 
with a file that has between 240 and 360 ppi. (Effects will use 
its internal resampling engine to ensure that your photo is at 
the final resolution you choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. If you wish the printer to handle the color conversion, select the 
Printer Managed Color option in the Profile list.

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. 

When choosing a specific paper profile—as opposed to Printer Managed Color—you can use Effects’ Soft 
Proofing feature to look at out-of-gamut colors in your photos. Click on the soft proof icon at the bottom 
left side of the window to view the photo with your chosen paper. (See “Soft Proofing” on page 73.)

NOTE: Effects’ Print feature will work with borderless printing options as well. 
Be sure to choose your printer’s borderless options in the page setup pop-up. 
Different printers will have specific borderless settings, so check the manual to 
see how to turn borderless printing on.

The Printer pane sets printer-specific options for the 
current print job. You can also choose to render the 
print job to a PDF file.
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Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Effects will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, Effects will create a PDF of the photo (or photos) and save it with the name and destination 
you specified earlier.

PRINT AREA PANE

The Print Area pane is where you set the options for the size 
of the print, and how you wish your photos to be printed. 
You can also choose whether to print photos individually or 
package-style. (The contact sheet option, while present, is not 
applicable in Effects, as it is largely designed to gang-print a set 
of different photos.)

The top of the pane includes preset styles for either fitting the 
current photo inside the size of the print, or filling the entire 
size of the print. It also includes options for printing at common 
print sizes, including 8x10, 5x7, 4x6; and options for printing to 
a contact sheet. You can also create custom print sizes via the 
Custom section at the bottom of the pane; just set the width 
and height of the print size, and whether you wish to fit the 
image to the print size, or to fill the frame with it. If you would like to save this print size as a style, click on 
the More pop-up at the top of the pane, and choose Save as New Style from the menu. You’ll then be able 
to recall that style from the More pop-up whenever you print.

If you are printing multiple copies of a single photo, Effects will attempt to put as many photos at your 
chosen print size on the paper size as defined in the Printer pane. To print only one photo per page, click 
that option at the bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print size 
of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, 
and is most often used for your logo, signature or copyright. 
Watermarks generally need a transparent background, so make 
sure your watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-
up.

• Size: This slider controls the size of the watermark 
file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it 
to appear 2 inches wide on a 300-ppi image, your watermark 
needs to be at least 600 pixels wide. Otherwise, it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, 
for example—you’ll need to add an additional sharpening 
step when printing. This is an additional level of sharpening 
beyond anything you might have applied in the Effects or Local 
Adjustment panels. 

The Sharpening pane lets you select a type of sharpening that 
will be applied to your photos during the printing process. 
The pop-up menu has a set of options for general sharpening, 
including ones for a standard print, glossy papers, details, high-
pass sharpening, and many more. Depending upon the image, 
you might need to play with the settings here; performing test 
prints on small sections of a photo can often be quite helpful in 
determining the proper level of sharpening in a print.
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PART 6: EXPORT
Export is a special function that is available inside ON1 Effects 2026. The Export window gives you the 
power of ON1’s patented Resize technology in an easy-to-use panel, letting you export your photos with 
incredible flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel 
contains specific types of options—file renaming, destination folders, file type and more—that you can use 
when you are exporting images from Effects. If you find that you are using a specific set of options all the 
time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A.	Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.

B.	 Save Preset: Lets you save the current set of export options as a preset.
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C.	 Naming: Renames the exported file based on criteria added to the rename box in the panel.

D.	Destination: Lets you set the destination of the exported files. (required)

E.	 File Type: Sets the file type for each exported file. (required)

F.	 Resize: Adjusts the size for each image. 

G.	Sharpening: Applies sharpening to the exported images.

H.	Metadata: Adds/removes metadata from the export. 

I.	 Watermark: Lets you add a text or graphic watermark to an exported image. 

J.	 Export/Cancel: Starts the exporting, or cancels it and returns you to Effects.

 Export Options

NAMING

The Naming pane gives you extensive controls 
for creating customized filenames using tokens 
in the entry box inside the pane, as well as with 
any custom text entered directly into the entry 
box. You can use any combination of tokens 
and text in the entry box, and the Example label 
directly above the box will display what your 
new filename will look like, using the first item in 
the export group.

To use this feature, click the control circle to the left of the label in the panel. Add any custom text, or 
click the Add Token pop-up menu to add tokens based on information associated with the image, including 
filename data, date and time information, and associated metadata There are four submenus in the Add 
Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence is intended for batch processing of images. (Not applicable when exporting from 
Effects, which processes a single image at a time.) 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common token combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undo-able, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Effects will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found starting on page 133.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip will leave the destination file alone and not export the 
new file, and Keep Both will add a number ‘1’ to the end of the filename of the exported file, 
preserving both files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Effects completes the exporting process. 
Options include displaying the image location in the MacOS Finder or Windows Explorer, to 
create a ZIP archive of the exported group, to open in another editing application, or to run a 
script.
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FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Effects can export in 
DNG, PSD, TIFF, JPG and PNG formats. With 
the exception of DNG and PNG, each file format 
has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
patented Genuine Fractals technology found 
in ON1 Resize. It has seven options for export: 
Dimensions, Long and Short Edge, Width and 
Height, Megapixels and Percentage. Each option 
has a different range of settings, and all have a 
setting for resolution (in pixels per inch, or ppi), 
as well as a Don’t Enlarge option, which, when 
set, will not upscale a file past its native image dimensions (but will still export the file). 

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock icon to resize the images proportionally as you enter either the width or the height, or, if 
you wish to fit the images to an exact width and height, click the lock icon to turn it off. If an exported 
image doesn’t exactly fit the dimensions you set for Width and Height, Export will do one of two things, 
depending upon whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the 
Resolution box.

• Fit in Dimensions will fit the exported file inside the boundaries of the width and height 
settings.

The Resize pane, with the Dimensions option open.
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• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the width 
and height settings, essentially cropping the exported image. If the image’s aspect ratio is 
different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust the Amount (overall strength), Radius (detail) and Threshold 
(masks out areas that shouldn’t be sharpened based on contrast). 

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with the 
images in the export set. You can choose to export 
all Metadata or by clicking the control circle to the 
right of the All Metadata label. If you click that label 
off, you can then select which metadata items you 
wish to save by clicking the appropriate label.

When checked, the Remove Unmanaged XMP 
button only exports metadata that ON1 recognizes as standard metadata fields; any unmanaged image 
metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 16), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 

Use the Position grid at the bottom of the pane to place your watermark, and use the Size and Inset sliders 
to move it within the area chosen. The Opacity slider adjusts the transparency of the watermark on the 
final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 127), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 
from the Presets menu, make your changes, and choose Update Preset with Current Settings from the 
Presets menu. You can also rename and delete watermark presets from this menu.

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all 
of the other panes alone, and click Export. Effects will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Effects will 
ask you if you wish to update the preset with the new settings 
either when you click the Export button to start the process, or 
when you switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

About Effects’ File-Naming Tokens
When using the Naming option in the Export window, Effects includes a broad set of tokens that you 
can use as part of the strings to build complex file names, in conjunction with any custom text you wish 
to enter. These tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC 
metadata fields, and can be used in any number of combinations.

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.
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To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files to exacting specifications, all drawn from file 
information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when exporting a group of image files, and, as such is not 
applicable within Effects.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

Ratings and Labels

The three tokens in the Ratings and Labels submenu (shown 
below) pull information from any rating, label and like 
information stored with images opened in Effects.

The Rating token will add the number of stars an image 
is rated, while the Label token will add any color label 
information (red, yellow, green, blue, purple), and the Likes 
token will add Liked, Not Set, or Disliked to the image name.



ON1 Effects 2026 User Guide	 Part 6: Export	 136

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. You can use these tokens if you know that an imported file has stored IPTC Metadata 
information.   
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SHARING OPTIONS (MAC ONLY)
The MacOS version of ON1 Effects 2026 includes a number of photo-sharing options, including:

• AirDrop: Uses Apple’s AirDrop networking feature to share with local MacOS or iOS devices. 

• Mail: Creates a new email message in Apple Mail with the shared photo.

• Messages: Shares photo to Apple’s Messages app.

• Notes: Adds the shared photo to Apple’s Notes app. You can choose to create a new note, or 
add the photo to an existing note.

• Add to Photos: Adds the photo to Apple’s Photos app.

• Reminders: Adds to the Reminders app.

• Shortcuts: Sends to the Shortcuts app.

• Additional email apps (Mimestream): Creates a new mail message with the shared photo in 
any additional email apps registered on your Mac.  

All of the sharing options perform the same operation: Effects exports a full-size JPEG of the selected 
photo and shares it with the selected target from the list. 
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EFFECTS MENUS

ON1 EFFECTS 2026 (MACOS ONLY)

• About ON1 Effects 2026: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (This option is In 
the Edit menu on Windows)

• Quit ON1 Effects: Quits ON1 Effects 2026.

FILE MENU

• Done: Saves your edited photo and quits Effects.

• Cancel: Cancels the current editing operation.

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using a 
preset from the hierarchical menu, bypassing the Export 
window.

• Export with Previous: Exports the current selection with the 
last-used Export setting, bypassing the Export window.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

EDIT MENU

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Undo Delete: [unused]

• Redo Delete: [unused]

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Delete: [unused]

• Revert: Reverts to the original state of the current photo.

• Keyboard Shortcuts: Lets you add or modify the hotkeys for 
many of Effects’ commands. 

• Preferences (Windows): Opens the Preferences dialog.
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MASK MENU

• Refine Mask: Opens the Refine Mask window.

• Invert Mask: Inverts the mask, what was hidden is revealed 
and vice versa.

• Reset Mask: Resets the mask to its original state (white or 
black).

• Enable/Disable: Toggle’s the current mask’s state.

• Paste Inverted: Pastes a copied mask into a new location and 
inverts it.

• Add Mask: Lets you create a mask using any of the options 
available in the Masking Properties window.

• Show Mask: Displays the current mask either as a red overlay 
or as grayscale.

• View Mode: Sets the Show Mask mode to either a color 
overlay, a color overlay displayed only when brushing, or as 
grayscale.

SETTINGS MENU

• Reset All Settings: Resets all of the settings applied to a 
photo, returning it to the state it was when opened.

• Reset Effects Settings: Resets settings applied in Effects.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings as Preset: Saves the editing settings of the 
selected photo as a preset.

• Update Preset with Current Settings: If an image with a 
preset has had some settings changed, this lets you update 
the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web page.

• Save Settings: Saves the current state of your edits, in case of 
crash.

• New Snapshot: Creates a new snapshot state.
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VIEW MENU

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 1, 2 or 
3 columns.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• Compare: Displays an adjustable split-screen view of the 
current image, with the Before view on the left side of the 
preview area.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Effects will set the 
white point and black point of the display to account for that 
of the chosen profile.

• Auto Hide Tool Options bar: When checked, the Tool Options 
bar for each tool will be hidden on-screen, and becomes 
visible when you hover over the top of the main window.

• Enter Full Screen: Toggles full-screen mode (hides menus).
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WINDOW

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Full Screen Preview: Displays the current photo full-screen, 
without any additional interface elements.

• Solo Mode: Keeps only one pane open at a time.

• Layers: Sets display and nesting options for the Layers pane.

• Properties: Sets display and nesting options for the Properties 
window.

• Open Quick View Browser: Opens the Quick View Browser 
overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the bumper text labels.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Show Right Bumper: Hides/reveals the legacy right-side 
bumper from previous versions of Effects.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

HELP

• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub window in Effects.

• ON1 Effects 2026 Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Show Module Tips: Displays tool tips for the current view.

• Check for Updates: Checks the ON1 update server to see 
if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Effects 2026.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Effects 2026.
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PREFERENCES
ON1 Effects 2026 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Effects 2026 menu (MacOS) or the Edit menu in Windows. The Preferences window has four 
tabs: General, Files, Plug-Ins, System, Services. The settings in each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings for the Effects workspace, including background color, 
scrolling controls and more.

Font Size

Sets the size of the text in the basic Effects workspace 
(labels, panes and pop-up menus) to one of three general 
sizes: Small, Medium, Large. 

When changing the font size, you must quit and restart 
Effects for the new setting to take effect.

Preview Background Color

You may select the color of the background behind 
the preview image. The default is black. The custom 
option has a color picker where you can select your own 
background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Effects interface.

Application Language

Lets you change the display language for Effects. Auto will use your system’s default language.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Only Adjust Brush Size with Scroll Wheel

Turning on this option overrides Effects’ default behavior, setting the app so that your mouse’s scroll wheel 
will only change the size of a brush (when an appropriate tool is selected). 

When not checked, Effects uses the scroll wheel to scroll, zoom, pan and adjust brush size and feathering, 
depending upon the modifier keys being pressed. See page 21 for specifics on the default settings for 
scroll wheel options in Effects. 
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FILES

Sidecar Options

Click this box if you wish Effects 2026 to create 
ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using multiple 
computers, and want your edits to be visible 
on each machine. The sidecar file contains the 
editing information used inside Effects. 

Default Processing

Apply Lens Correction Automatically will use 
lens correction information automatically on any 
raw photo opened in ON1 Effects. Choosing 
Disable Base Corrections on Raw Files will turn off the basic raw-file correction settings. This can be 
helpful for scientific/technical photography, time-lapse, and other specialized applications.

PLUG-INS

Plug-Ins is specific to using Effects as a plugin 
Photoshop or Lightroom, and lets you set up 
conditions when opening files from these apps.

General

Checking the “Leave ‘ON1 Effects 2026’ open 
when done will keep the app open after you’ve 
edited an image via a plugin.

Photoshop
• Apply Results to: When editing in 

Photoshop you can choose to have your 
effect added to a copy of your current 
layer or to the current layer. You can also 
choose to start with the last used settings 
when launching Effects.

Lightroom

This preference sets options for files opened via 
the Plug-In Extras menu in Lightroom:

• File Type: The file type drop-down menu 
determines what type of file will be created. The default is PSD, which maintains layers. You can also 
select ON1’s Smart Photo format to preserve re-editability from within Lightroom, and JPG or TIFF if 
you prefer those formats. The last option, ‘Same as Source,’ maintains the file type of the original file, 
except for Lightroom raw files, which are saved as PSDs.
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• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

• Ask Every Time: Presents these export options whenever you chose an item from the Plug-In Extras 
submenu. Turning this option off will bypass the file-export window, using the options in the Plug-In 
Preferences window every time.

NOTE: For detailed information about the Smart Photo format and options 
from within Lightroom, see page 11.

Apple Photos (MacOS only)
• The Enable Helper option works to ensure a smooth connection between Apple Photos and ON1 

Effects. It should remain on by default.

SYSTEM

The System tab displays performance-related characteristics of Effects 
2026.

AI processor

Sets the processing option for AI-based operations. By default, the option 
is set to Auto, which uses the best combination of system resources to 
process tasks. If you are noticing some performance issues with Effects, 
you can try setting the options to either your CPU or your graphics card.

Memory Usage
• System Usage: Specifies the amount of RAM that is used by the 

application. The maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) that is 
used by the application. The maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running Effects. This is helpful if your system drive has limited space and wish to use a faster external drive 
as a cache. This cache information is purged each time you quit the application.
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Performance

The Performance section is designed to help you optimize Effects for your specific setup. There are three 
options, Low, Adaptive (the default), and High.
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